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Préface

1. Au sujet de Mandrake Linux

Mandrake Linux est une distribution GNU/Linux développée par MandrakeSoft S.A. La société Mandrake-
Soft est née sur Internet en 1998 ; son ambition première demeure de fournir un système GNU/Linux convivial
et facile à utiliser. Les deux piliers de MandrakeSoft sont le logiciel libre et le travail coopératif.

1.1. Contacter la communauté Mandrake

Nous présentons ci-dessous plusieurs liens Internet pointant vers de nombreuses ressources liées à Mandrake
Linux. Si vous souhaitez en savoir plus sur la société MandrakeSoft, consultez son site Web (http://www.
mandrakesoft.com/). Un site dédié à la distribution Mandrake Linux (http://www.mandrakelinux.com/) et
tous ses dérivés existe également.

MandrakeExpert (http://www.mandrakeexpert.com/) est la plate-forme d’aide en ligne de MandrakeSoft. Il
propose une nouvelle façon de partager les savoirs s’appuyant sur la confiance et le plaisir de récompenser
son prochain pour son aide. Il s’agit d’un concept différent des autres plate-formes d’aide en ligne.

Vous êtes également invité à participer aux nombreuses listes de diffusion (http://www.mandrake-inux.com/
fr/flists.php3), où la communauté Mandrake Linux déploie tout son enthousiasme et sa vivacité.

Enfin, n’oubliez pas de vous connecter sur MandrakeSecure (http://www.mandrakesecure.net/). Ce site
rassemble tout ce qui traite de la sécurité des distributions Mandrake Linux. Vous y trouverez notamment des
avertissements de bogues et de sécurité, ainsi que des articles traitant de sécurité informatique et de privacité.
Bref, voilà un site incontournable pour tout administrateur système, ou tout utilisateur soucieux de sécurité.

1.2. Rejoignez le Club

MandrakeSoft est heureux d’offrir à ses utilisateurs une large palette d’avantages grâce au Club des utilisa-
teurs de Mandrake Linux (http://www.mandrakelinux.com/fr/club/) :

• télécharger des logiciels commerciaux, qui ne sont normalement disponibles que dans les packs de détail,
tels que des pilotes logiciel, des applications commerciales, des partagiciels et des versions démo ;

• voter et proposer de nouveaux logiciels à travers un système de vote RPM que des bénévoles maintienne ;

• accéder à plus de 50.000 paquetages RPM pour toutes les distributions Mandrake Linux ;

• obtenir des remises pour des produits et services sur le MandrakeStore (http://www.mandrakestore.com) ;

• accéder à une meilleure liste de miroirs, exclusive aux membres du Club ;

• lire des forums et articles multilingues.

Le MandrakeClub est l’endroit idéal pour vous faire entendre !

En finançant MandrakeSoft par l’entremise du MandrakeClub, vous améliorerez directement la distribution
Mandrake Linux et vous nous permettrez de proposer le meilleur poste de travail GNU/Linux possible à nos
utilisateurs.

1.3. Acquérir des produits Mandrake

Les utilisateurs de Mandrake Linux désirant acheter en ligne peuvent désormais le faire simplement en
consultant le MandrakeStore (http://www.mandrakestore.com). Vous y trouverez des logiciels Mandrake
Linux – systèmes d’exploitation et outils réseau (pare-feu) (Multi Network Firewall), mais aussi des offres spé-
ciales d’abonnement, de l’assistance, des logiciels tiers et des licences, des manuels et des livres GNU/Linux ,
ainsi que d’autres gadgets MandrakeSoft.
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1.4. Contribuer à Mandrake Linux

Quels que soient vos talents, vous êtes encouragé à participer à l’une des nombreuses tâches requise à la
construction du système Mandrake Linux :

• Paquetages. Un système GNU/Linux est principalement constitué de programmes rassemblés depuis Inter-
net. Ils doivent être mis en forme de façon à ce qu’ils puissent fonctionner ensemble, si tout se passe bien ;

• Programmation. Une foule de projets est directement développée par MandrakeSoft : trouvez celui qui
vous intéresse le plus et proposez votre aide au développeur principal ;

• Internationalisation. vous pouvez nous aider à traduire des pages de nos sites Web, des programmes et
leur documentation respective.

• Documentation. Afin de suivre l’évolution rapide du système, nous ne comptons plus le temps et les efforts
investis pour que le manuel que vous êtes en train de lire demeure à jour. Rédacteurs et traducteurs seront
accueillis à bras ouverts !

Consultez aussi les pages des contributeurs (http://www.mandrakesoft.com/labs/) pour en savoir plus sur
les différentes façons de contribuer à l’évolution de Mandrake Linux.

2. À propos de ce mini-guide d’installation

Bienvenue, et merci d’avoir opté pour Mandrake Linux ! Ce Mini-guide d’installation vous guidera pas à pas
dans l’installation d’une distribution GNU/Linux . Il vous donnera des points de repères concernant ce dont
vous avez besoin avant d’installer le système d’exploitation Mandrake Linux. Il vous initiera également à
l’environnement GNU/Linux .

Avertissement pour l’installation, page 3 vous informera des procédures techniques que vous devriez appliquer
(ce n’est pas obligatoire, mais disons que nous vous suggérons fortement de suivre les instructions de ce
chapitre). Nous y discuterons de sauvegarde de données, de scandisk, et plus encore.

Dans Avant l’installation, page 5, nous couvrirons des sujets tels que la configuration du BIOS, les disquettes
de démarrage et le matériel pris en charge.

Puis vient le chapitre le plus important : Installation avec DrakX, page 9. Il vous guidera durant tout le processus
d’installation proprement dit.

Bonne chance !
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Chapitre 1. Avertissement pour l’installation

Ce guide d’installation couvre seulement les étapes les plus courantes de l’installation. Si vous avez l’intention
d’utiliser Windows ainsi que GNU/Linux en dual boot (ce qui signifie que vous aurez la possibilité d’accéder aux
deux OS sur le même ordinateur), notez qu’il est plus facile d’installer Windows avant GNU/Linux . Si Windows
est déjà installé sur votre ordinateur et que vous n’avez jamais installé GNU/Linux auparavant, DrakX , le pro-
gramme d’installation de Mandrake Linux, devra redimensionner votre partition Windows . Cette opération
peut s’avérer dangereuse pour vos données. Par conséquent, vous devez effectuer les tâches suivantes avant
de continuer :

• Vous devez lancer scandisk sur votre disque Windows : le programme de redimensionnement peut détecter
certaines erreurs, mais scandisk est plus adapté pour ce faire ;

Avant d’utiliser scandisk (ou defrag) assurez-vous que votre éco-
nomiseur d’écran et tout autre programme soient désactivés et
fermés. La procédure la plus sûre est encore de lancer scandisk

dans le mode protégé ou sans échec (Safe Mode) de Windows .

• Afin d’optimiser la sécurité de vos données, vous devriez aussi lancer defrag sur votre partition, opération
qui vous donne une protection supplémentaire face au risque de perdre des données : cette étape n’est pas
obligatoire, mais fortement recommandée. Le redimensionnement sera également plus rapide ;

• L’assurance ultime contre tous les problèmes possibles est de toujours sauvegarder vos données ! Bien sûr,
sauvegardez-les sur un autre ordinateur, envoyez vos sauvegardes sur Internet, sur l’ordinateur d’un ami,
etc. Ne les gardez pas sur l’ordinateur où vous souhaitez installer GNU/Linux .

Si ni scandisk ni defrag ne sont installés sous Windows , consultez la documentation de Windows et installez-
les.

Partitions NTFS. Les utilisateurs de Windows 2000 , NT ou XP

doivent être particulièrement attentifs : il est possible de redimen-
sionner une partition NTFS avec GNU/Linux mais il est toutefois
recommandé de sauvegarder vos données.
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Chapitre 2. Avant l’installation

Ce chapitre concerne les opérations à effectuer avant l’installation. Assurez-vous de lire ce chapitre en entier,
sa lecture vous évitera beaucoup de soucis. Enfin, sauvegardez vos données (sur un autre disque que celui
où vous désirez installer Mandrake Linux) et mettez sous tension tous vos périphériques externes (souris,
clavier, imprimante, scanner, etc.).

2.1. Petite configuration du BIOS

Le BIOS (Basic Input/Output System, soit système d’entrées/sorties de base) sert à trouver le périphérique sur
lequel est situé le système d’exploitation et à le démarrer. Il est également responsable de la configuration
initiale du matériel.

L’apparition du plug’n’play et sa démocratisation font en sorte que tous les BIOS modernes ont la possibilité
d’initialiser de tels périphériques. Afin que Linux puisse reconnaître les périphériques plug’n’play , votre
BIOS devrait être configuré pour les initialiser.

Pour changer la configuration de votre BIOS , il suffit généralement de maintenir la touche Suppr (ou F2,
F10, Esc selon le BIOS ) enfoncée juste après la mise sous tension de la machine. Il existe malheureusement
beaucoup de types de BIOS . Vous devrez donc rechercher par vous-même l’option adéquate. Elle est souvent
intitulée PnP OS installed (ou Plug'n'Play OS installed). Mettez cette option à No : le BIOS initialisera ainsi
les périphériques plug’n’play , ce qui peut aider GNU/Linux à reconnaître certains périphériques de votre
machine : il ne le pourrait pas autrement.

Tous les systèmes récents peuvent démarrer à partir du CD-ROM. Recherchez la fonction Boot sequence dans
les paramètres du BIOS , et sélectionnez CD-ROM comme première entrée. Si votre BIOS ne permet pas cela,
vous devrez créer une disquette de démarrage d’installation.

Si vous souhaitez utiliser une imprimante connectée localement
à votre machine, assurez-vous que le port parallèle soit en mode
ECP+EPP (ou au moins l’un des deux) et non pas en mode SPP,
à moins que votre imprimante ne soit vraiment vieille. Si vous ne
pouvez pas changer de mode, vous pourrez imprimer quand mê-
me, mais votre imprimante ne sera pas reconnue automatiquement
et vous devrez la configurer manuellement. Assurez-vous aussi que
l’imprimante soit correctement connectée et sous tension.

2.2. Créer une disquette de démarrage

Il se peut que votre système soit incapable de démarrer depuis le CD-ROM. Le CD-ROM contient tous les
fichiers image et utilitaires requis.

Les images de démarrage (boot) se trouvent dans le répertoire images du CD-ROM.

Plusieurs images sont disponibles et servent à différentes méthodes d’installation :

cdrom.img

Pour lancer une installation depuis un lecteur CD-ROM local IDE ou SCSI. Vous devez utiliser cette image
si vous n’arrivez pas à changer les paramètres de votre BIOS de façon à démarrer directement depuis le
CD-ROM.

network.img

Pour installer depuis un répertoire NFS, FTP, HTTP, depuis un réseau local ou encore via une connexion
Internet haute vitesse PPPoE (ligne DSL). La configuration réseau de la machine à installer pourra être
automatique (DHCP) ou manuelle ;
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Chapitre 2. Avant l’installation

pcmcia.img

À utiliser si la source d’installation est accessible à travers une carte PCMCIA (réseau, CD-ROM, etc.) ;

Certaines cartes PCMCIA utilisent maintenant des pilotes (drivers)
de réseau standards. Si votre carte PCMCIA ne fonctionne pas,
essayez l’image network.img.

hd.img

Utilisez cette image si vous souhaitez installer Mandrake Linux depuis un disque dur local. Vous n’avez
qu’à copier le contenu du CD sur le disque dur (sur une partition FAT ext2FS, ext3FS ou ReiserFS), et à
démarrer avec la disquette contenant cette image ;

hdcdrom_usb.img

Cette image permet de lancer une installation par réseau à travers un périphérique de stockage USB, tel
qu’un CD-ROM ou un disque dur externe USB.

network_gigabit_usb.img

network_gigabit_usb.img : Pour installer depuis un répertoire NFS, FTP, HTTP, en utilisant un adapta-
teur réseau Gigabit (GbE) ou USB ;

Le répertoire /images/alternatives/* contient plus ou moins les mêmes images d’initialisation, mais avec
un noyau (kernel) différent. Précisément, c’est le noyau 2.2 (Mandrake Linux 9.1 utilise le noyau 2.4) qui vous
aidera peut-être avec des systèmes plus vieux.

2.2.1. Création d’une disquette de démarrage sous Windows

Si Windows est installé sur votre ordinateur, vous devez utiliser le programme rawwrite. Celui-ci se trouve
dans le répertoire dosutils du CD.

Notez qu’il existe une version DOS (rawrite) du même programme. En fait, c’est la version originale du pro-
gramme, et rawwrite en est simplement une interface graphique.

Lancez le programme comme le montre la figure 2-1.

Figure 2-1. Le programme rawwrite

Sélectionnez l’image à copier et le périphérique cible. Dans la majorité des cas, ce dernier sera le lecteur A: (le
premier lecteur de disquettes).
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Puis, si ce n’est déjà fait, insérez une disquette vierge dans le lecteur choisi et cliquez sur Write. Lorsque
l’opération sera terminée, cliquez sur Exit. Vous aurez alors une disquette de démarrage pour l’installation de
votre distribution Mandrake Linux.

2.2.2. Création d’une disquette de démarrage sous GNU/Linux

Si vous disposez déjà d’une installation de GNU/Linux (autre version, sur une autre machine, etc.), effectuez
les étapes suivantes :

• montez le CD-ROM. Nous supposerons que le point de montage est /mnt/cdrom ;

• connectez-vous en tant que root. Pour ce faire, ouvrez une console, tapez la commande su et entrez le mot
de passe root;

• insérez une disquette vierge dans le lecteur de disquette et tapez :
$ dd if=/mnt/cdrom/images/cdrom.img of=/dev/fd0

Si vous utilisez le deuxième lecteur de disquette, remplacez /dev/

fd0 par /dev/fd1. Remplacez aussi le nom de l’image par celle qui
vous convient. Votre disquette de démarrage est maintenant prête.

2.3. Matériel reconnu

Mandrake Linux reconnaît un très grand nombre de périphériques matériel, et la liste est bien trop longue
pour être citée en intégralité ici. Néanmoins, certaines démarches détaillées dans ce chapitre vous permettront
de vous assurer de la compatibilité de votre matériel et, le cas échéant, de pouvoir configurer certains des
périphériques douteux.

Il existe une liste à jour de matériel agréé sur notre site Web (http://www.mandrakelinux.com/fr/hardware.
php3).

Les périphériques USB 1.1 et USB 2.0 sont désormais très bien pris en charge sur GNU/Linux . Vous pouvez
consulter une liste de tous ceux-ci sur le site Linux-USB Device (http://www.qbik.ch/usb/devices/).

Clause de non-responsabilité légale : la liste de matériel agréé
par Mandrake Linux contient des informations à propos des pé-
riphériques matériel qui ont été testés ou ont été signalés comme
fonctionnant correctement sous Mandrake Linux. Du fait de la
grande variété des configurations, MandrakeSoft ne peut pas ga-
rantir qu’un périphérique spécifique fonctionnera correctement sous
votre système.

2.3.1. Ce qui n’est pas reconnu

Dans l’état actuel des choses, certains types de matériel ne peuvent être certifiés sous GNU/Linux , soit parce
que la prise en charge en est encore à l’état expérimental, soit parce que personne n’a écrit de pilote pour les
périphériques en question, ou parce qu’il a été décidé de ne pas les certifier pour des raisons valables. Voici
quelques exemples.

• Les winmodems , nommés aussi modems sans contrôleur ou modems logiciel. La prise en charge de ces
périphériques en est encore à ses balbutiements. Des pilotes existent, mais en mode binaire et ceci seulement
pour certains d’entre eux.

Si vous possédez un modem PCI, regardez la sortie de cat /proc/pci en tant que root. Cela vous indiquera
le port I/O ainsi que l’IRQ de ce périphérique. Puis, utilisez la commande setserial (dans notre exemple,
l’adresse I/O est 0xb400, l’IRQ est 10 et notre modem sera le quatrième périphérique série) comme suit :
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Chapitre 2. Avant l’installation

setserial /dev/ttyS3 port 0xb400 irq 10 UART 16550A

Voyez alors si vous pouvez interroger votre modem avec minicom ou kppp . Si cela ne fonctionne pas, il
se peut que vous ayez un modem logiciel. Si cela fonctionne, créez le fichier /etc/rc.d/rc.setserial et
placez-y la commande setserial appropriée.

Un projet, mis en marche récemment, essaie de faire fonctionner ces modems sous GNU/Linux . Si vous avez
un de ces périphériques, vous pouvez consulter le site linmodems (http://linmodems.org) et modems et
winmodems (http://www.idir.net/~gromitkc/winmodem.html).
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Chapitre 3. Installation avec DrakX

3.1. Introduction au programme d’installation de Mandrake Linux

DrakX est le logiciel d’installation pour Mandrake Linux. Avec DrakX , peu importe que vous soyez un nouvel
utilisateur de Mandrake Linux ou un vieux pro –– la tâche de DrakX consiste à vous fournir une installation
simple et une transition facile vers la dernière version de Mandrake Linux.

Afin d’assurer une installation complète et sans embûches, vérifiez
que tous vos périphériques soient bien branchés et sous tension.
DrakX détectera et configurera automatiquement tous les appareils
ainsi reliés à votre ordinateur.

Figure 3-1. Écran de bienvenue, le début de l’installation

Au début de l’installation, que ce soit par CD-ROM ou disquette, le premier écran vous propose de l’aide (fi-
gure 3-1). Ne rien faire démarrera l’installation en mode standard, dénommé « linux ». Nous allons maintenant
détailler quelques unes des options du programme d’installation, utiles en cas de problème.

En appuyant sur F1, un écran d’aide apparaît. Voici les options qui vous y sont proposées :

Figure 3-2. Options disponibles pour l’installation
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Chapitre 3. Installation avec DrakX

• vgalo : Si vous avez essayé une installation normale et qu’il vous a été impossible de voir l’interface graphi-
que telle que démontrée plus loin (figure 3-3), vous pouvez essayer d’utiliser une résolution plus basse.
Cela peut arriver avec certaines cartes graphiques, de sorte que Mandrake Linux vous donne la possibilité
de contourner ce problème dû le plus souvent à des cartes obsolètes. Pour essayer l’installation en basse
résolution, taper vgalo à l’invite.

• text : Dans la situation où vous utilisez une très vieille carte vidéo et que l’installation en mode graphique
refuse de démarrer, le mode text vous permettra de poursuivre l’installation.

• Le mode noauto : dans certains cas isolés, la détection du matériel peut bloquer votre ordinateur. Si cela
arrive, vous pouvez ajouter le mot noauto comme paramètre pour que l’installation ne lance pas de dé-
tection matérielle. Mais sachez que vous devrez alors fournir l’ensemble des paramètres de votre matériel
manuellement. Le paramètre noauto est une option pour les modes précédents, vous pouvez donc spécifier :
boot: vgalo noauto

pour lancer une installation en basse résolution sans détection automatique du matériel.

• options du noyau : la grande majorité des machines n’ont pas besoin d’options spécifiques sur le noyau.
Cependant du fait d’erreurs de conception ou de BIOS défectueux, certaines cartes mères ne reconnaissent
pas correctement la quantité de mémoire installée. Si vous devez spécifier manuellement la quantité de
DRAM installée, utilisez l’option mem=xxxxM. Par exemple, pour démarrer une installation en mode stan-
dard sur un PC ayant 256 Mo de mémoire vive, entrez la commande suivante :
boot: linux mem=256M

Maintenant que nous avons passé en revue tout ce qui pourrait arriver, voyons le processus d’installation lui-
même. Quand l’installation démarre, vous pouvez voir une interface graphique évoluée (figure 3-3). À gauche,
les différentes phases d’installation sont identifiées. Vous remarquerez que l’installation va se dérouler en deux
étapes distinctes : installation du système, puis configuration. Toutes les étapes sont listées à gauche, et l’étape
courante est signalée par une puce plus claire.

Chaque étape peut afficher plusieurs écrans. La navigation entre ces écrans se fait grâce aux boutons Sui-
vant -> et <- Précédent. En outre un bouton Avancé pourra être disponible pour avoir accès à des options
supplémentaires.

Le bouton Aide montrera des explications concernant l’étape en
cours.

3.2. Choix de la langue

La première étape consiste à choisir votre langue.
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Figure 3-3. Choix de la langue par défaut

Le choix de la langue sera appliqué à la documentation, l’installation et le système en général. Commencez
par choisir la région où vous vous situez, puis la langue que vous parlez.

En cliquant sur Avancé, le programme vous proposera également des langues complémentaires pouvant être
installées sur votre station de travail. En choisissant des langues supplémentaires, le programme vous ins-
tallera toute la documentation et les applications nécessaires à l’utilisation de ces langues. Par exemple, si
vous prévoyez d’accueillir des utilisateurs d’Espagne sur votre machine, choisissez le français comme langue
principale dans l’arborescence, et Español, dans la section avancée.

À propos de l’encodage UTF-8 (unicode): Unicode est un nouveau
système d’encodage des caractères censé couvrir tous les langages
existants. Cependant son intégration dans GNU/Linux est encore
imparfaite. Pour cette raison, Mandrake Linux l’utilisera ou non
selon les critères suivants :

1. Si vous choisissez une langue avec un encodage ayant une
longue histoire (langages associés à latin1, Russe, Japo-
nais, Chinois, Coréen, Thäı, Grec, Turc, et la plupart des
langages iso-8859-2), l’encodage historique sera utilisé;

2. Les autres langages entrâıneront l’utilisation d’unicode
par défaut;

3. Si vous demandez l’installation de plus d’une langue, et
que ces langues n’utilisent pas le même encodage, alors
unicode sera utilisé pour tout le système;

4. Enfin, unicode peut aussi être utilisé quelque soit vo-
tre configuration des langues à utiliser, en sélectionnant
l’option Utiliser Unicode par défaut.

Remarquez que vous n’êtes pas limité à une langue supplémentaire. Vous pouvez en choisir plusieurs, ou
même les installer toutes en choisissant Toutes les langues. Choisir le support pour une langue signifie ajouter
les traductions, les polices, correcteurs orthographiques, etc.

Pour passer d’une langue à l’autre, vous pouvez lancer l’utilitaire
/usr/sbin/localedrake en tant que root pour changer la langue
utilisée dans tout le système ; connectez-vous en simple utilisateur
pour ne changer que la langue de cet utilisateur.
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3.3. Licence de la distribution

Avant d’aller plus loin, il est fortement recommandé de lire attentivement les termes et conditions d’utilisation
de la licence. Celle-ci régit l’ensemble de la distribution Mandrake Linux. Si vous en acceptez tous les termes,
cochez la case Accepter, sinon, cliquez sur le bouton Quitter pour redémarrer votre ordinateur.

3.4. Configuration de la souris

Cette étape est généralement ignorée en mode Recommandé.

DrakX détecte généralement le nombre de boutons de votre souris. Sinon, il prend pour acquis que vous avez
une souris à deux boutons et configurera l’émulation du troisième bouton. De plus, DrakX saura automatique-
ment si vous avez une souris PS/2, série ou USB.

Si vous désirez installer une souris différente, veuillez la sélectionner à partir de la liste qui vous est proposée.

Si vous sélectionnez une souris différente de celle choisie par défaut, DrakX vous présentera un écran de
test. Utilisez les boutons et la molette pour vous assurer que tout fonctionne correctement. Si votre souris ne
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fonctionne pas normalement, appuyez sur la barre d’espacement ou la touche Entrée pour annuler le test et
retourner à la liste de choix de la souris.

Parfois, les souris à roulette ne sont pas détectées. Vous devrez
alors sélectionner manuellement une souris dans la liste. Assurez
vous de choisir celle qui correspond à votre modèle et au bon port
de connexion. Après avoir pressé le bouton OK, une image de souris
apparâıt. Vous devez alors faire tourner la molette afin de l’activer
correctement. Testez alors que tous les mouvements et boutons
fonctionnent correctement.

3.5. Classe d’installation

Cette étape ne s’affiche que si une partition GNU/Linux a été détectée sur votre disque dur.

DrakX doit maintenant savoir quel type d’installation vous désirez réaliser. Deux types d’installation sont
proposés : Par défaut ( Recommandée), qui limite le nombre de questions à l’utilisateur au minimum ou Expert
qui vous permet de sélectionner individuellement chacune des composantes à installer. Il vous est également
proposé de faire une Installation ou une Mise à jour d’un système Mandrake Linux déjà installé :

• Installation : Remplace l’ancien système. En fait, selon ce que votre machine comporte, vous pourrez garder
intactes certaines des anciennes partitions (Linux ou autres) ;

• Mise à jour : cette classe d’installation permet de mettre à jour seulement les paquetages qui composent votre
système Mandrake Linux. Elle conserve les partitions existantes, ainsi que la configuration des utilisateurs.
La plupart des autres étapes d’une installation classique sont accessibles.

La mise à jour devrait fonctionner correctement pour les systèmes
Mandrake Linux à partir de la version 8.1. Essayer de lancer une
mise à jour sur les versions antérieures à 8.1 n’est pas recommandé.

3.6. Configuration du clavier

Cette étape est généralement ignorée en mode Recommandé.
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Selon la langue principale que vous avez choisie à l’étape Choix de la langue, page 10, DrakX sélectionne le
clavier approprié. Vérifiez que cela correspond effectivement à votre configuration de clavier ou choisissez
une autre configuration dans la liste.

Cela dit, il est possible que vous ayez un clavier ne correspondant pas exactement à votre langue d’utilisation.
Par exemple, si vous habitez le Québec et parlez le français et l’anglais, vous pouvez vous trouver dans la
situation où votre language et votre configuration de clavier ne sont pas les même. Dans ces cas, cette étape
vous permet de sélectionner un autre clavier à partir de la liste.

Cliquez sur Davantage pour voir toutes les options proposées.

Si vous choisissez un clavier basé sur un alphabet non-latin, on vous demandera au prochain écran de choisir
la combinaison de touches permettant d’alterner entre ceux-ci.

3.7. Création des partitions

Cette étape vous permet de déterminer précisément l’emplacement de votre installation de Mandrake Linux.
Si votre disque est vide ou utilisé par un autre système d’exploitation, vous devrez repartitionner votre disque.
Partitionner un disque désigne l’opération consistant à le diviser précisément afin de créer un espace pour
votre installation.
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Comme les effets du partitionnement sont irréversibles (l’ensemble du disque est effacé), le partitionnement
est généralement intimidant et stressant pour un utilisateur inexpérimenté. Heureusement, un assistant a été
prévu à cet effet. Avant de commencer, révisez vos manuels et surtout, prenez votre temps.

Selon la configuration de votre disque, plusieurs options sont disponibles :

• Utilisez l'espace disponible : cette option tentera simplement de partitionner automatiquement l’espace inu-
tilisé sur votre disque. Il n’y aura pas d’autre question.

• Utiliser les partitions existantes : l’ assistant a détecté une ou plusieurs partitions existant sur votre disque.
Si vous voulez les utiliser, choisissez cette option. Il vous sera alors demandé de choisir les points de mon-
tage associés à chacune des partitions. Les anciens points de montage sont sélectionnés par défaut, et vous
devriez généralement les garder.

• Utilisez l'espace libre sur une partition Windows : si Microsoft Windows est installé sur votre disque et en
prend toute la place vous devez faire de la place pour votre installation GNU/Linux . Pour ce faire, vous
pouvez tout effacer (voir « effacer tout le disque ») ou vous pouvez redimensionner la partition Windows

FAT ou NTFS. Le redimensionnement peut être effectué sans pertes de données, à condition que vous ayez
préalablement défragmenté la partition Windows. Une sauvegarde de vos données ne fera pas de mal non
plus. Cette solution est recommandée pour faire cohabiter Mandrake Linux and Microsoft Windows sur le
même ordinateur.

Avant de choisir cette option, il faut comprendre qu’après cette procédure l’espace disponible pour Windows
sera réduit. Vous aurez moins d’espace pour installer des logiciels ou sauvegarder de l’information avec
Windows.

• E�acer tout le disque: si vous voulez effacer toutes les données et les applications installées sur votre système
et les remplacer par votre nouveau système Mandrake Linux, choisissez cette option. Soyez prudent, car ce
choix est irréversible et permanent. Il vous sera impossible de retrouver vos données effacées.

En choisissant cette option, l’ensemble du contenu de votre disque
sera détruit.

• Supprimer Microsoft Windows: ce choix effacera tout simplement ce que contient le disque et recommencera
à zéro. Toutes les données et les programmes présents sur le disque seront effacés.

En choisissant cette option, l’ensemble de votre disque sera effacé

• Partitionnement personnalisé : permet de partitionner manuellement votre disque. Soyez prudent, car bien
que plus puissante, cette option est dangereuse. Vous pouvez facilement perdre l’ensemble du contenu d’un
disque. Donc, ne choisissez pas cette option si vous ne savez pas exactement ce que vous devez faire. Pour
en savoir plus sur DiskDrake , référez vous à Gérer ses partitions du Guide de démarrage.

3.8. Choix des partitions à formater

Cette étape est généralement ignorée en mode Recommandé.
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Les partitions ayant été nouvellement définies doivent être formatées (ce qui implique la création d’un système
de fichiers).

Lors de cette étape, vous pouvez reformater des partitions existantes pour effacer les données présentes. Vous
devrez alors également les sélectionner.

Sachez qu’il n’est pas nécessaire de reformater toutes les partitions existantes. Vous devez formater les parti-
tions contenant le système d’exploitation (comme /, /usr ou /var, mais il n’est pas nécessaire de formater les
partitions de données, notamment /home...

Soyez prudent. Une fois que les partitions sélectionnées seront reformatées, il sera impossible de récupérer
des données.

Cliquez sur OK lorsque vous êtes prêt à formater les partitions.

Cliquez sur Annuler pour ajouter ou enlever une partition à formater.

Cliquer sur Avancé si vous désirez sélectionner des partitions pour une vérification des secteurs défectueux
(Bad Blocks).

3.9. Installation à partir de plusieurs CD-Roms
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Les paquetages requis à l’installation de Mandrake Linux sont distribués sur plusieurs CD-ROM. Si un paque-
tage requis se trouve sur un autre CD-ROM, DrakX éjectera celui présent dans le lecteur et vous demandera
d’insérer le CD-ROM approprié.

3.10. Mot de passe root

Vous devez prendre ici une décision cruciale pour la sécurité de votre système. L’utilisateur root est
l’administrateur du système qui a tous les droits d’accès aux fichiers de configuration, etc. Il est donc im-
pératif de choisir un mot de passe difficile à deviner (pensez aux systèmes prévus à cet effet qui anticipent
les combinaisons communes des utilisateurs). DrakX vous avertira si le mot de passe entré est trop facile à
deviner. Comme vous pouvez le voir, il est également possible de ne pas entrer de mot de passe. Nous dé-
conseillons fortement cette pratique. Comme l’erreur est humaine, un utilisateur avec tous les droits peut tout
détruire sur votre système, c’est pourquoi le mot de passe doit agir comme barrière à l’entrée.

Le mot de passe choisi devrait contenir au moins 8 caractères alphanumériques. Ne jamais écrire un mot de
passe, forcez-vous à vous en souvenir par coeur. Il faut donc ménager accessibilité et mémoire, donc un mot
de passe de 30 caractères est presque impossible à mémoriser.

Afin d’éviter les regards indiscrets, le mot de passe n’apparaîtra pas à l’écran. Il vous faudra donc l’inscrire
deux fois afin d’éviter les erreurs de frappe. Évidemment, si vous faites deux fois la même erreur, celle-ci sera
sauvegardée et vous devrez la reproduire afin d’accéder à votre système pour la première fois.

En mode expert, on vous demandera si vous comptez vous connecter sur un serveur d’authentification, tel
que NIS ou LDAP. Si votre réseau utilise un de ces protocoles, il faut le sélectionner. Si vous n’en avez aucune
idée, demandez à votre administrateur réseau.

Si vous souhaitez que l’accès à cette machine soit contrôlé par un serveur d’authentification, cliquez sur le
bouton Avancé.

Si votre réseau utilise soit LDAP, NIS, ou un PDC Windows , choisissez-le comme protocole d’authentification.
En cas de doute, demandez à votre administrateur réseau.

Si vous avez des problèmes à vous souvenir de vos mots de passe,
vous pouvez choisir Aucun, si votre ordinateur ne sera pas connecté
à Internet, et si vous avez confiance en tous ceux qui auront accès
à cette machine.
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3.11. Ajouter un utilisateur

GNU/Linux est un système multi-utilisateurs, ce qui signifie généralement que chaque utilisateur peut avoir
des préférences différentes, ses propres fichiers, etc. Pour plus d’informations, consultez le Guide de démarrage.
Contrairement à root qui a tous les droits, les utilisateurs que vous ajouterez ici n’auront que des permissions
pour agir sur leurs propres fichiers exclusivement. L’utilisateur / administrateur devrait également se créer
un compte « normal ». C’est à travers cet utilisateur que celui-ci devrait se connecter pour accomplir ses tâches
quotidiennes. Car, bien qu’il soit pratique d’avoir tous les accès, cette situation peut également engendrer des
situations désastreuses si un fichier est détruit par inadvertance. Un utilisateur normal n’ayant pas accès aux
fichiers sensibles, ne peut causer de dommages majeurs.

Il faut d’abord entrer le vrai nom de la personne. Évidemment, vous pouvez y inscrire n’importe quoi. DrakX
prendra le premier mot inséré et le transposera comme Nom de login. C’est le nom qui sera utilisé pour se
connecter au système. Vous pouvez le modifier. Il faut maintenant entrer un mot de passe. Celui-ci n’est pas
aussi crucial que le mot de passe de root, mais ce n’est pas une raison pour rentrer 123456. Après tout, ceci
mettrait vos fichiers en péril.

Après avoir cliqué sur Accepter l'utilisateur, il vous sera possible d’ajouter d’autres utilisateurs. Créez un
utilisateur différent pour chaque personne devant utiliser votre ordinateur. Une fois chaque utilisateur défini,
cliquez sur Suivant ->.

En cliquant sur Avancé, vous pourrez sélectionner un shell diffé-
rent pour cet utilisateur (bash est assigné par défaut).
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Lorsque vous avez fini d’installer tous les utilisateurs, il vous est proposé de choisir un utilisateur qui sera
automatiquement connecté lors du démarrage de l’ordinateur. Si cela vous intéresse (et que la sécurité locale
ne soit pas trop un problème), choisissez l’utilisateur et le gestionnaire de fenêtres, puis cliquez sur Suivant ->.
Si cela ne vous intéresse pas, décochez la case Voulez-vous utiliser cette fonctionnalité?.

3.12. Installation du programme d’amorce

Cette étape est généralement ignorée en mode Recommandé.

LILO et GRUB sont deux programmes d’amorce pour GNU/Linux . Cette étape est normalement complètement
automatique. En fait, DrakX analyse le secteur de démarrage (master boot record) et agit en fonction de ce qu’il
peut y lire :

• si un secteur de démarrage Windows est détecté, il sera remplacé par GRUB/LILO . Donc, vous serez capable
de démarrer GNU/Linux ou tout autre système d’exploitation installé sur votre machine.

• si GRUB ou LILO est détecté, il sera remplacé par la nouvelle version;
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En cas de doute, DrakX affiche différentes options. En général, le Premier secteur du disque (MBR) est l’endroit
le plus sûr. Si vous choisissez Passer, aucun chargeur de démarrage ne sera installé. À vos risques et périls.

3.13. Vérifications de divers paramètres

3.13.1. Résumé

On vous présente ici diverses informations sur la configuration actuelle. Selon le matériel installé, certaines
entrées seront présentes et d’autres pas. Chaque paramètre est constitué du nom de la configuration, suivi
d’un cours résumé de la configuration actuelle. Cliquez sur le bouton Con�gurer correspondant pour changer
cela.

• Clavier: vérifiez la configuration choisie pour le clavier.

• Pays : vérifiez la section du pays. Si vous ne vous trouvez pas dans ce pays, cliquez sur le bouton Con�gurer
et choisissez le bon. Si votre pays ne se trouve pas dans la première liste, cliquez sur Plus pour avoir la liste
complète.

• Fuseau horaire: DrakX , par défaut, configure le fuseau horaire selon le pays dans lequel vous vous trouvez.

• Souris: pour vérifier la configuration actuelle de la souris. Cliquez sur le bouton pour modifier les options.

• Imprimante : en cliquant sur Con�gurer, l’outil de configuration d’impression sera démarré. Consultez le
chapitre correspondant du Guide de démarrage pour plus de renseignements. L’interface qui y est documentée
est similaire à celle rencontrée lors de l’installation.

• Carte son : si une carte son a été détectée, elle apparaîtra ici. Si vous remarquez que la carte configurée n’est
pas celle qui se trouve effectivement sur votre système, vous pouvez cliquer sur le bouton pour en choisir
une autre.

• Interface graphique : par défaut, DrakX configure votre interface graphique avec une résolution de 800x600
ou 1024x768. Si cela ne vous convient pas, cliquez sur Con�gurer pour changer la configuration de votre
interface graphique.

• Carte TV : si une carte d’entrée/sortie vidéo (carte TV) a été détectée, elle apparaîtra ici. Si vous avez une
carte TV et qu’elle n’a pas été détectée, cliquez sur ce bouton pour la configurer à la main.

• Carte RNIS : si une carte RNIS (ISDN) est détectée, elle apparaîtra ici. Vous pouvez cliquer sur le bouton
pour en modifier les paramètres.

• Réseau : si vous souhaitez configurer votre accès Internet ou réseau local dès maintenant.

• Niveau de sécurité : il vous est ici proposé de redéfinir votre niveau de sécurité.
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• Pare-feu : si vous avez l’intention de connecter votre ordinateur à Internet, c’est une bonne idée de le proté-
ger des intrusions grâce à un pare-feu. Consultez la section correspondante du Guide de démarrage pour plus
de renseignements.

• Chargeur de démarrage : si vous souhaitez changer la configuration par défaut de votre chargeur de démar-
rage. À réserver aux utilisateurs expérimentés.

• Services : vous pourrez ici contrôler finement les services disponibles sur votre machine. Si vous envisagez
de monter un serveur, c’est une bonne idée de vérifier cette configuration.

3.13.2. Options de fuseau horaire

Ce dialogue apparaît après que vous ayez sélectionné un nouveau fuseau horaire dans la liste. Deux options
supplémentaires s’offrent alors.

GNU/Linux manipule l’heure au format GMT (Greenwich Mean Time) et la convertit en temps local selon le
fuseau horaire choisi. Il est néanmoins possible de désactiver cela en désélectionnant Horloge système réglée
sur le méridien de Greenwich de façon à ce que l’horloge matérielle soit la même que celle du système. Cela est
particulièrement utile si la machine accueille un autre système d’exploitation tel que Windows .

La Synchronisation automatique permet de régler l’heure automatiquement en se connectant à un serveur de
temps sur Internet. Dans la liste qui est alors présentée, choisissez un serveur géographiquement proche de
vous. Vous devez avoir une connexion Internet pour que cela fonctionne bien entendu. Cela installera en fait
sur votre machine un serveur de temps local qui pourra, en option, être lui-même utilisé par d’autres machines
de votre réseau local.
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3.13.3. Configuration de X, le serveur graphique

X (pour le système X Window) est le coeur de votre interface graphique sous GNU/Linux . Tous les environne-
ments graphiques (KDE , GNOME , WindowMaker etc.) présents sur Mandrake Linux dépendent de X.

Il vous sera présenté une liste de divers paramètres à changer pour obtenir un affichage optimal :

Carte graphique

Le programme d’installation détecte et configure automatiquement les cartes graphiques présentes sur
votre machine. Si ce n’est pas le cas, vous pouvez choisir dans cette liste la carte que vous utilisez effecti-
vement.

Dans le cas où différents serveurs seraient disponibles pour votre carte, avec ou sans accélération 3D, il
vous est alors proposé de choisir le serveur qui vous conviendra le mieux.

Moniteur

Le programme d’installation détecte et configure automatiquement les moniteurs connectés à votre unité
centrale. Si ce n’est pas le cas, vous pouvez choisir dans cette liste le moniteur que vous utilisez effective-
ment.

Résolution

Vous pouvez choisir ici la résolution et nombre de couleurs parmi celles disponibles pour votre matériel.
Choisissez la configuration optimale pour votre utilisation (vous pourrez néanmoins modifier cela après
l’installation). Un échantillon de la configuration choisie apparaît dans le dessin du moniteur.

Test

Selon votre matériel cette option peut ne pas apparâıtre.

le système va ici essayer d’ouvrir un écran graphique à la résolution choisie. Si vous pouvez voir le mes-
sage pendant le test, et répondez Oui, alors DrakX passera à l’étape suivante. Si vous ne pouvez pas voir
de message, cela signifie que vos paramètres sont incompatibles, et le test se terminera automatiquement
après 12 secondes. Changez la configuration jusqu’à obtenir un affichage correct lors du test.
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Options

Vous pourrez également choisir ici de démarrer l’interface graphique au lancement de la machine. Il
est préférable de choisir Non si vous êtes en train d’installer un serveur, ou si vous n’avez pas réussi à
configurer l’écran correctement.

3.13.4. Configuration réseau

Cette étape est généralement ignorée en mode Recommandé.

Si vous désirez connecter votre système à un réseau ou à Internet, cliquez sur OK. L’auto-détection des pé-
riphériques réseau et modem sera alors lancée. Si cette détection échoue, décochez la case Utiliser l'auto-
détection. Vous pouvez aussi choisir de ne pas configurer le réseau, ou de le faire plus tard. Dans ce cas,
cliquez simplement sur Annuler.

Les types de connexion supportées sont : modem téléphonique, Winmodem, modem ISDN, connexion ADSL,
modem câble ou simplement LAN (réseau Ethernet).

Nous ne détaillerons pas ici chacune des configurations possibles. Assurez-vous seulement que vous avez
toutes les informations de votre fournisseur de service Internet à portée de main.

À propos des Winmodems Les Winmodems sont des modems de
bas de gamme généralement intégrés à la carte mère de l’ordinateur
qui ont besoin d’un logiciel additionnel pour fonctionner par rapport
aux modems standards. Certains de ces modems fonctionnent avec
Mandrake Linux, d’autres non. Vous pouvez consulter la liste des
modems pris en charge chez LinModems (http://www.linmodems.
org).

Vous pouvez consulter le chapitre du Guide de démarrage concernant les connexions à Internet pour plus de dé-
tails à propos des configurations spécifiques de chaque type de connexion. Vous pouvez également configurer
votre connexion à Internet une fois l’installation terminée.
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3.13.5. Installer un programme d’amorce

Cette étape est généralement ignorée en mode Recommandé.

Ce dialogue permet de contrôler finement le chargeur de démarrage :

• Programme d'amorçage à utiliser vous propose trois choix :

1. GRUB : si vous préférez GRUB (menu texte).

2. LILO en mode texte : si vous préférez la version texte de LILO.

3. LILO en mode graphique : si vous préférez l’interface graphique.

• Périphériques de démarrage : dans la plupart des cas, vous n’aurez pas à changer le disque par dé-
faut (/dev/hda, mais si vous le désirez, le programme d’amorce peut être installé sur un second disque,
/dev/hdb, ou même sur une disquette, /dev/fd0.

• Délais avant l'activation du choix par défaut : au redémarrage de l’ordinateur, il s’agit du temps accordé à
l’utilisateur pour démarrer un autre système d’exploitation.

• Activer l'ACPI: l’ACPI est un nouveau standard (apparu courant 2002) pour la gestion d’énergie, surtout
pour les portables. Si vous savez que votre matériel est compatible ACPI cochez cette case.

• Forcer sans APIC: Si vous avez remarqué auparavant des problèmes matériels sur votre machine (conflits
IRQ, instabilités, blocages machine, ...) vous pouvez essayer de désactiver l’APIC en cochant cette case.

Prenez garde, si vous décidez de ne pas installer de programme
d’amorce (en cliquant sur Passer), vous devez vous assurer d’avoir
une méthode pour démarrer le système. Aussi, assurez-vous de bien
savoir ce que vous faites si vous modifiez les options.

En cliquant sur Avancée, vous aurez accès à plusieurs autres options
de configuration. Sachez que celles-ci sont réservées aux experts en
la matière.
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3.13.6. Configuration des options du logiciel de démarrage (Bootloader).

Cette étape est généralement ignorée en mode Recommandé.

Après avoir configuré les paramètres généraux de LILO ou GRUB la liste des options de démarrage sera rendue
disponible au démarrage.

Si d’autres systèmes d’exploitation sont détectés, il seront automatiquement ajoutés au menu démarrage. Vous
pouvez ici affiner votre configuration. Cliquez sur Ajouter pour créer une nouvelle entrée ; Choisissez une
entrée et cliquez Modi�er pour l’éditer, ou Supprimer pour l’enlever. Suivant -> validera vos changements.

Il est possible que vous vouliez limiter l’accès à ce système
d’exploitation. Il vous suffit de retirer l’entrée dans les options de
démarrage et démarrer ce système avec une disquette.

3.13.7. Sélection des services disponibles au démarrage

Cette étape est généralement ignorée en mode Recommandé.

Vous pouvez maintenant choisir les services disponibles au démarrage de votre système.

Ici sont présentés tous les services disponibles avec l’installation en place. Faites une bonne vérification et
enlevez tout ce qui n’est pas absolument nécessaire au démarrage du système.

Vous pouvez obtenir une courte explication des services en les
sélectionnant spécifiquement. Cela dit, si vous n’êtes pas sûr de
l’application d’un service, conservez les paramètres par défaut.

À cette étape, soyez particulièrement attentif dans le cas d’un systè-
me destiné à agir comme serveur. Dans ce cas, vous voudrez pro-
bablement permettre exclusivement les services nécessaires.
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3.14. Installation de mises à jour depuis Internet

Au moment où vous êtes en train d’installer Mandrake Linux, il est possible que certains paquetages aient été
mis à jour depuis la sortie du produit. Des bogues ont pu être corrigés, et des problèmes de sécurité résolus.
Pour vous permettre de bénéficier de ces mises à jour, il vous est maintenant proposé de les télécharger depuis
Internet. Choisissez Oui si vous avez une connexion Internet, ou Non si vous préférez installer les mises à jour
plus tard.

En choisissant Oui, la liste des sites depuis lesquels les mises à jour peuvent être téléchargées est affichée.
Choisissez le site le plus proche. Puis un arbre de choix des paquetages apparaît : vérifiez la sélection, puis
cliquez sur Installer pour télécharger et installer les mises à jour sélectionnées, ou Annuler pour abandonner.

3.15. L’installation est maintenant terminée !

Votre installation de Mandrake Linux est maintenant terminée et votre système est prêt à être utilisé. Cliquez
sur Redémarrer pour redémarrer votre système. N’oubliez pas de retirer la source d’installation(CD-ROM ou
disquette). La première chose que vous verrez alors après que l’ordinateur ait fait ses propres tests matériels
est le menu de démarrage, permettant de démarrer tous les systèmes présents sur votre machine.
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Le bouton Avancée (en mode Expert uniquement) permet deux
autres options :

1. Générer une disquette d'auto-install: Pour créer une
disquette d’installation qui permettra de reproduire
l’installation que vous venez de réaliser sans l’aide d’un
administrateur.

Notez que les deux options suivantes apparaissent après
avoir cliqué sur le bouton :

� Replay. C’est une installation partiellement automa-
tique où il est possible de personnaliser le partitionne-
ment du disque (exclusivement).

� Automatique. Complètement automatique, cette ins-
tallation reformate le disque au complet.

Cette fonctionnalité est particulièrement pratique pour
l’installation de multiples systèmes. Voir la section Au-
to install (http://www.linux-mandrake.com/drakx/
auto_inst.html) de notre site Internet.

2. Sauvegarder les paquetages sélectionnés sauvegarde la
sélection des paquetages installés. Puis, lorsque vous fe-
rez une autre installation, insérez la disquette dans le lec-
teur et accédez au menu d’aide en tapant F1, et entrez
la commande suivante : linux defcfg="floppy".

3.16. Désinstaller Linux

Les systèmes d’exploitation n’offrent généralement pas la possibilité de se désinstaller. Mandrake Linux est
fière de vous offrir la liberté de faire cela.

Le processus s’effectue en deux étapes simples:

1. Détruire toutes les partitions allouées à Mandrake Linux sur votre disque ’généralement les partitions de
type ext3 et swap) et les remplacer éventuellement par une seule partition FAT en utilisant DiskDrake .

Supprimer des partitions de votre disque dur effacera immanqua-
blement toutes les données qui se trouvaient sur lesdites partitions.
Assurez-vous donc de sauvegarder les données que vous souhaiteriez
garder avant de lancer cette étape.

2. Désinstaller le programme d’amorce (généralement LILO ) du secteur de démarrage (MBR). Pour ce faire,
démarrer sous DOS et lancer la commande : fdisk /mbr.

Si vous utilisez un autre système d’exploitation, celui-ci inclut sans doute de la documentation concernant
l’installation de son programme d’amorce (boot loader).

Au revoir. Merci d’avoir utilisé Mandrake Linux!
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Chapitre 4. Passer à Linux depuis Windows®/Mac OS X®

Ce chapitre est destiné aux utilisateurs habitués à Windows ou MacOS X . Plutôt que de présenter les applica-
tions en profondeur, ce chapitre tentera de répondre à quelques questions de base qu’un ancien utilisateur de
Windows ou MacOS X pourrait se poser.

4.1. Où se trouve mon... ?

Les utilisateurs aguerris de Windows et MacOS X sont habitués à certaines fonctions et concepts qui sont traités
différemment avec GNU/Linux .

4.1.1. Menu Démarrer

Ce concept reste similaire. On parlera dans ce manuel du menu principal, qui est représenté sous KDE par un
grand « K » en bas à gauche du bureau.

Les utilisateurs de MacOS X sont cependant habitués à quelque-chose d’un peu différent. Le menu Pomme
(situé à gauche de la barre de menu) ne contient pas d’applications, mais propose divers services. Vos appli-
cations étaient disponibles dans le dossier Applications du « Finder ».

4.1.2. Applications

C’est vraiment différent sous GNU/Linux . En premier lieu, Mandrake Linux installe beaucoup plus
d’applications lors de l’installation initiale. Le menu Mandrake donne accès à une multitude de choix pour
une tâche précise. Il existe en effet plusieurs applications de niveau professionnel pour accomplir une même
tâche, que ce soit du traitement de texte ou d’image, courrier électronique, etc..

Pour les utilisateurs de MacOS X , un certains nombre d’application leur seront familières. MacOS X étant issu
de BSD , un grand nombre d’applications sont semblables, certaines ont même été portées d’un environnement
à l’autre et sont donc identiques sous GNU/Linux et MacOS X .

Il est aussi possible de rajouter un grand nombre d’applications grâce à RpmDrake .

4.1.3. Centre de contrôle et préférences système

Le Panneau de contrôle de Windows ou l’outil de Préférences système de MacOS X sont remplacés par le
Centre de contrôle Mandrake sous Mandrake Linux.Il se trouve dans le menu principal : Administrez votre
système→Con�gurer votre ordinateur. À travers cet outil vous aurez accès à la plupart des paramètres de votre
machine, sous interface graphique.

4.1.4. Fenêtre DOS

GNU/Linux reste fidèle à sa ligne de commande (command line). Et contrairement aux environnements Windows ,
leur popularité ne fait que s’accroître comme c’est le cas sous MacOS X . Par défaut, Mandrake Linux installe
bash , un shell (ligne de commande) réellement puissant. Vous pouvez y accéder en ouvrant le menu principal
puis en sélectionnant Administrez votre système→Utilisez un émulateur de terminal.

Aucune de vos commandes ou fonctions DOS ne fonctionnera sous
GNU/Linux . Jetez un coup d’oeil au chapitre Introduction à la ligne
de commande du Manuel de référence pour découvrir les fonctions
équivalentes, et plus encore. Amusez-vous, vous avez maintenant
une véritable ligne de commande en main !
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4.1.5. Voisinage réseau

Puisque GNU/Linux n’utilise pas le protocole réseau SMB (le protocole réseau de Windows ), par défaut (il utilise
TCP/IP), il n’y a pas d’équivalent vous permettant d’avoir une vue rapide du réseau dans lequel vous vous
trouvez. Vous pouvez toutefois utiliser l’application LinNeighborhood qui offre des fonctionnalités similaires.

Vous pouvez aussi utiliser Konqueror pour accomplir la même tâche. Dans la barre d’adresse, tapez :
lan:/ pour Konqueror ou smb:/ pour Nautilus , et tous les partages Windows de votre réseau apparaîtront.
Assurez vous au préalable que le samba-client soit bien installés.

4.1.6. Lecteur C:

C’est là un concept unique à Windows . Sur les systèmes UNIX , la notion de disque (C:\, D:\, A:\) est remplacée
par des « points de montage ». Du point de vue utilisateur, vous accéderez à des répertoires. Selon la confi-
guration déployée, le noyau « monte » tous les disques, leurs partitions et les systèmes distants (par réseau),
puis, il leur alloue un répertoire dans l’arborescence de fichiers. Ce concept se rapproche du système utilisé
par MacOS X . Ce qui se trouve dans /mnt avec GNU/Linux est monté dans /Volumes sous MacOS X mais est
disponible est tant que « système de fichier racine » dans le Finder .

C’est d’ailleurs ce qui permet à GNU/Linux de lire n’importe quel système de fichiers, même vos répertoires
Windows .

4.1.7. Lecteur CD-ROM

Le même concept que pour C: s’applique ici. Les CD-ROM sont « montés » dans le répertoire /mnt/cdrom. Pour
y accéder, cliquez sur l’icône CD-ROM sur votre bureau. Si vous utilisez Nautilus , le CD-ROM apparaîtra
comme une nouvelle fenêtre instantanément.

Malheureusement cela ne marche pas pour un CD audio. Vous pou-
vez toutefois lire vos CDs sans problèmes. Consultez Applications
audio et vidéo dans le Guide de démarrage.

4.1.8. Lecteur de disquettes

Tout comme les CD-ROM et les partitions disque, les disquettes sont « montées » dans un répertoire, soit
/mnt/floppy. Cliquez sur l’icône du bureau pour y accéder. Les disquettes Windows sont reconnues automa-
tiquement.

Le bureau propose des icônes pour accéder aux lecteurs de disque
amovibles tels que disquette, CD-ROM, ZIP , etc.

4.1.9. Mes Documents

Avec Mandrake Linux, chaque utilisateur dispose d’un dossier Documents/ situé dans son répertoire person-
nel (home).

Le concept de dossier personnel (home) est équivalent aux répertoires \winnt\Profiles\user_name\ ou \Do-
cuments and Settings\user_name\ sous Windows NT/Windows 2000/Windows XP .

Sous MacOS X nous avions un système similaire, le répertoire personnel étant disponible dans /Users/nom_
utilisateur lequel dossier contenait aussi un dossier Documents.

Vous avez également probablement de nombreux documents en format propriétaire issus de Excel ou Word .
Ceux-ci s’avèrent généralement assez simples à convertir. Sachez que OpenOffice.org , pour ne nommer
qu’un logiciel, peut importer la plupart des formats bureautique courants.
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Nous ne parlons que des documents bureautiques car c’est là
un exemple révélateur. Pour des raisons d’espace, nous ne pou-
vons pas énumérer chaque application Windows et son équi-
valent GNU/Linux . Il est en effet probable que vous trouviez
l’équivalent GNU/Linux de tous les programmes que vous utili-
sez sous Windows ou MacOS X . Pour avoir une idée des applica-
tions GNU/Linux équivalentes à celles de Windows , vous pou-
vez consulter cette table d’équivalence (http://linuxshop.ru/
linuxbegin/win-lin-soft-en/).

4.2. Le Meilleur des Mondes !

Maintenant que vous vous sentez plus à l’aise avec GNU/Linux , voici une brève présentation des fonctionnali-
tés qui justifient à elles seules la migration vers GNU/Linux .

4.2.1. Un environnement multiutilisateurs

GNU/Linux , de même que MacOS X , est basé sur UNIX . Ceci implique un changement de structure important,
d’un poste de travail à un environnement multiutilisateurs. Cela engendre également une gestion des uti-
lisateurs et des permissions plus rigoureuse. Chacun des fichiers, services et applications est exclusivement
alloué à un utilisateur ou à un groupe d’utilisateurs, selon leur nature. Par exemple, chaque utilisateur pos-
sède un répertoire « personnel », généralement inaccessible aux autres et contenant tous des renseignements
personnels.

GNU/Linux offre également de nombreuses fonctionnalités serveur en standard, comme l’hébergement de ser-
vices de courrier électronique ou de pages Web.

4.2.2. Un environnement multitâches

GNU/Linux a toujours été un système d’exploitation très fort en matière de tâches multiples (multi-tasking).
Même si les concurrents Windows et MacOS se sont grandement améliorés dans cet aspect, GNU/Linux demeure
un champion en la matière.

4.2.3. De multiples bureaux

Avec GNU/Linux , que vous utilisiez GNOME ou KDE , vous avez toujours quatre (4) espaces de travail disponibles,
plutôt qu’un. Les utilisateurs qui aiment lancer beaucoup d’applications en même temps apprécieront cette
fonctionnalité qui permet de mieux organiser son environnement de travail.

4.2.4. Le contrôle total sur votre bureau !

Concernant l’apparence graphique et la convivialité (look’n’feel), GNU/Linux « casse la baraque ». Non seule-
ment avez-vous le choix entre GNOME , KDE et quelques autres interfaces graphiques, mais vous pouvez éga-
lement leur appliquer des « thèmes ». En fait, tout ce que vous voyez à l’écran peut être modifié, de l’image
d’arrière-plan au comportement des fenêtres quand vous les fermez, et cela est vraiment unique.

Consultez www.themes.org (http://www.themes.org/)pour voir d’autres designs disponibles.

4.2.5. Des milliers d’applications gratuites

De loin, la communauté GNU/Linux est la plus généreuse... Face à un problème, vous trouverez sans doute un
script ou une application capable de répondre à vos besoins, gratuitement ! Aussi, Mandrake Linux comprend
des centaines de logiciels, non documentés dans ce livre. Ne soyez pas intimidé et essayez-les. Vous serez sans
doute surpris par les possibilités que GNU/Linux offre.
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4.2.6. Finis les redémarrages !

Les utilisateurs de Windows et dans une moindre mesure, de MacOS connaissent le niveau de frustration généré
par un système qui plante constamment. Même si GNU/Linux n’est pas parfait, sa stabilité reste un de ses
points forts. Il arrive qu’une application plante, mais il vous faudra rarement redémarrer pour que le système
fonctionne.

Nous espérons que ce survol rapide vous aidera à apprécier les atouts de GNU/Linux . N’ayez pas peur de
plonger encore plus avant !
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5.1. Introduction

Ce chapitre est destiné aux vrais débutants. Si la création d’une icône sur le bureau est pour vous un jeu
d’enfant, alors passez ce chapitre. Sinon, continuez ! Vous apprendrez comment accéder à votre environne-
ment de bureau, lancer des applications et éteindre l’ordinateur. Après avoir lu ce chapitre, la lecture de ce
manuel sera plus aisée.

Si vous êtes un utilisateur expérimenté de windows ou de MacOS , vous consulterez aussi avec profit la section
Passer à Linux depuis Windows®/Mac OS X®, page 29, qui vous aidera à faire la transition entre ces deux OS vers
GNU/Linux .

Nous supposerons que vous êtes confortablement installé devant un ordinateur sur lequel tourne Mandrake
Linux, qui affiche automatiquement l’écran de connexion graphique. Si ce n’est pas le cas et que vous êtes
devant un écran de type :

Mandrake Linux release 9.2 (CodeName) for i586

Kernel 2.4.22-9mdk on an i686 / tty 1

machine_name login:

avec un curseur clignotant, tapez votre identifiant (généralement votre prénom ou un surnom) puis votre mot
de passe. Vous devriez maintenant être « connecté ». Puis, tapez startx et l’interface graphique sera lancée.

Plusieurs interfaces graphiques sont disponibles sous GNU/Linux . Dans ce manuel, nous traiterons du très
populaire KDE .

5.2. Le menu du chargeur de démarrage (bootloader)

Lorsque vous redémarrez votre ordinateur après avoir complété l’installation de Mandrake Linux, vous ver-
rez le « menu du chargeur de démarrage », qui contient trois items ou plus. Il permet de démarrer votre
système GNU/Linux , tout autre système d’exploitation que vous auriez déjà installé, et quelques options spé-
ciales.

Le nombre d’items et leur nom peuvent varier. Celui qui nous intéresse, pour le moment, s’appelle linux, soit
celui qui démarrera votre système Mandrake Linux. Si vous ne le configurez pas différemment, c’est l’item
par défaut. Donc, tout ce que vous avez à faire est d’attendre quelques secondes –– vous verrez un compte à
rebours au bas de l’écran –– ou d’appuyer sur Enter, et Mandrake Linux sera chargé. Vous pouvez sélectionner
un autre item si vous voulez démarrer un autre système d’exploitation. Vous vous déplacerez d’item en item
au moyen des touches fléchées.

5.3. Se préparer pour sa session

Pendant que votre système Mandrake Linux se charge et qu’il vous affiche des renseignements techniques,
prenons le temps d’expliquer un concept commun aux systèmes multiutilisateurs : la session.

GNU/Linux est un système multiutilisateurs, ce qui signifie que plusieurs utilisateurs peuvent accéder à la
même machine. Chacun d’entre eux a la possibilité de protéger ses données et ses fichiers de configura-
tion en regard des autres utilisateurs. Pour ce faire, des comptes utilisateur différents doivent être créés
par l’administrateur système. Ce dernier s’appelle root et vous lui avez attribué un mot de passe lors de
l’installation du système : cet utilisateur peut tout faire sur votre système.

Il est également important de comprendre les termes « se connecter » (to log in) et « se déconnecter » (to log
out). Un parallèle peut être fait avec un agent de sécurité qui vous donnerait l’autorisation de pénétrer dans
un bâtiment gouvernemental. Après vous être connecté, le système entreprend une série d’actions afin de
vous donner accès aux ressources du système. En vous connectant, vous commencez ce que l’on appelle une
« session ».

À l’opposé, se déconnecter signifie prévenir le système que vous ne voulez plus l’utiliser. Votre session per-
sonnelle sera fermée, vous quitterez l’interface graphique et l’écran de connexion apparaîtra à nouveau.
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Quoique ces définitions soient valides à l’intérieur de ce chapitre,
elles sont très simplistes. À la lecture des chapitres suivants, vous
comprendrez mieux ces concepts, avantages et options.

5.4. Débuter votre session

5.4.1. Identifiez-vous

Pour vous connecter au système, vous avez besoin de votre nom de connexion et votre mot de passe. Le
premier vous identifie tandis que le second protège vos données sur l’ordinateur. Si la procédure d’installation
a été suivie avec soin, vous devriez déjà avoir ces deux mots. Si tel n’est pas le cas, demandez à la personne
qui a installé la machine.

Bien, assez de paroles, passons à l’acte ! Vous êtes actuellement devant cet écran (figure 5-1). Naturellement,
le vôtre peut être légèrement différent, comme les noms des utilisateurs (sous les icônes de pingouin).

Figure 5-1. La fenêtre de connexion

La procédure de connexion se fait en quatre étapes simples :

1. Cliquez sur l’icône correspondant à votre identifiant.

2. Lorsque le champ du mot de passe apparaît sous votre icône et identifiant, tapez votre mot de passe secret.

Comme vous pouvez le remarquer, les lettres n’apparaissent pas
comme vous les tapez : elles sont remplacées par de petites étoiles
* (des astérisques), de telle sorte que personne derrière vous ne
puisse lire votre mot de passe. C’est un comportement très commun
à chaque fois que vous devez entrer un mot de passe. Donc, assurez-
vous de bien taper sur les bonnes touches, étant donné que vous
ne pouvez pas vérifier ce que vous tapez. Sachez également que
les mots de passe différencient les majuscules des minuscules. Cela
signifie que si votre mot de passe est Tres_Secret et que vous
tapez Tres_secret, l’accès vous sera refusé !

3. Comme vous le voyez dans le champ Type de session, l’environnement par défaut est le dernier que
vous avez utilisé. Vous pouvez le changer simplement en en choisissant un autre dans le menu dérou-
lant. Si c’est la première fois que vous vous connectez, c’est-à-dire juste après l’installation, il n’y a pas
encore d’environnement par défaut, et l’assistant de première connexion Mandrake First Time Wizard

apparaîtra. Consultez L’assistant de première connexion (Mandrake First Time Wizard), page 35 pour plus de
renseignements.
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Figure 5-2. La liste des types de session

Cette étape est optionnelle et vous permet de choisir un environne-
ment graphique particulier. Essayez en plusieurs pour trouver votre
bonheur, mais pour débuter il vaut mieux commencer par KDE .

4. Enfin, cliquez simplement sur le bouton Entrer pour ouvrir votre session. Soyez patient ! Un laps de temps
de quelques secondes peut s’écouler avant que votre bureau ne soit en état de fonctionner.

Si vous êtes l’unique utilisateur de votre nouveau système Mandrake Linux, et si ça vous exaspère d’avoir à
rentrer votre mot de passe à chaque fois que vous allumez votre ordinateur, il y a un moyen de sauter cette
étape en démarrant directement votre environnement de bureau favori. Cette fonctionnalité s’appelle l’auto-
login et peut être activée comme suit :

• Lancez le Centre de contrôle Mandrake depuis le menu principal : Administrer votre système→
Con�gurez votre ordinateur, ou en cliquant sur l’icône du Centre de contrôle Mandrake .

• Cliquez sur la première section, Démarrage, puis sur l’icône de Drakboot.

• Cochez les options Lancer l'interface graphique au démarrage et Connexion automatique (choisir utilisateur
et environnement). Vous devez choisir l’environnement graphique à utiliser dans le menu déroulant au bas
de la fenêtre.

Soyez vigilant avec cette option : comme aucun mot de passe n’est
demandé, votre système est ouvert à toute personne se présentant
devant votre machine. N’utilisez cette option que si vous avez con-
fiance en toute personne susceptible d’approcher votre ordinateur
ou si vous n’y stockez aucune données importantes.

5.4.2. L’assistant de première connexion (Mandrake First Time Wizard)

Si c’est la première fois que vous accédez à un système Mandrake Linux, la fenêtre Mandrake First Time

Wizard (figure 5-3), contenant un programme qui vous aidera à régler des options basiques de configuration
apparaîtra. Nous vous recommandons de compléter toutes les étapes, ce qui vous fera gagner du temps dans
le futur.

Premièrement, il vous sera demandé de choisir une apparence visuelle pour votre environnement de travail.
Votre choix affectera la façon dont les fichiers, les objets et les fenêtres seront affichés à l’écran, ainsi que la ma-
nière avec laquelle vous interagirez avec ces éléments. Il est important de savoir que tous les environnements
graphiques partagent les mêmes fonctionnalités. Donc, vous serez en mesure d’effectuer les mêmes opéra-
tions et d’utiliser les mêmes programmes avec l’un ou l’autre des environnements proposés : d’en choisir un
au détriment d’un autre n’est qu’un choix personnel. Le choix par défaut est KDE .
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Figure 5-3. L’assistant de première connexion

Cliquez sur la flèche à côté du champ Choisissez un bureau pour voir les choix disponibles. Certains d’entre
eux proposent également plus d’une variation.

À la prochaine étape, vous aurez la possibilité d’entrer des renseignements nécessaires pour configurer vos
applications de messagerie électronique et de nouvelles. Vous devriez remplir les champs avec les données
que votre Fournisseur d’Accès Internet FAI) vous a données.

Enfin, vous pourrez créer un compte personnel MandrakeClub qui vous donnera un accès instantané à tous
les services en ligne offerts par MandrakeSoft Ces services incluent des téléchargements d’applications com-
merciales particuliers (dotés d’un mécanisme de téléchargement automatique et de procédures d’installation),
des forums multilingues, la possibilité de voter pour les paquetages logiciel que vous aimeriez que Mandrake
Linux inclut dans sa distribution, des remises sur achat, et plus. Votre distribution Mandrake Linux inclut
un abonnement d’un mois au MandrakeClub (essai) qui vous permettra d’évaluer les nombreux services dis-
ponibles. Ensuite, vous pourrez prolonger la durée de votre compte, si vous en voyez l’utilité (nous sommes
certains que ce sera le cas !).

De plus, si vous possédez déjà un compte MandrakeClub, Mandrake First Time Wizard vous aidera aussi
à configurer votre système pour permettre des téléchargements conviviaux et l’installation de mises à jour
spéciales depuis le site du MandrakeClub, et d’utiliser directement notre sympathique Software Manager .
Rappelez-vous que les adresses de courrier et les noms d’utilisateur sont uniques sur MandrakeClub. Donc,
vous ne serez pas en mesure d’ouvrir un compte d’essai si vous êtes déjà membre. Donc faites votre choix et
cliquez sur Suivant.

Une fois que l’introduction Mandrake First Time Wizard est complétée, votre nouvel environnement de tra-
vail sera affiché.

5.4.3. Quelques conseils concernant la sécurité

Il est important d’assimiler quelques notions de sécurité relatives à votre machine Mandrake Linux :

• N’écrivez pas votre mot de passe sur un bout de papier (un post-it par exemple) qui pourrait être vu par
n’importe qui.

• Assurez-vous que votre mot de passe soit assez complexe pour que personne ne le devine. Toutefois, il doit
être assez simple pour que vous vous en souveniez :-) Essayez d’utiliser un mélange de chiffres et de lettres
(majuscules et minuscules) pour vos mots de passe.
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C’est une bonne idée de penser à une phrase facile à retenir. Ensuite,
prenez les premiers chiffres et lettres de chacun des termes de votre
phrase pour créer un mot de passe. Par exemple, la phrase : Je
suis né le 10 septembre 1973 créerait le mot de passe suivant :
Jsnl1s1973, ce qui est relativement facile à retenir (après tout,
c’est votre date d’anniversaire...) et assez difficile à deviner par
quelqu’un d’autre.

• Si vous avez une connexion permanente à Internet ou à un réseau local, lorsque vous ne voulez plus utiliser
votre ordinateur, il est préférable de le fermer complètement. C’est-à-dire d’interrompre son fonctionne-
ment, et non de juste se déconnecter. Vous pouvez effectuer cette manœuvre en utilisant le bouton Éteindre
de la fenêtre de connexion.

La liste susmentionnée n’est pas du tout exhaustive. Il existe plusieurs façons d’améliorer la sécurité de votre
système. .

5.5. Utiliser votre environnement graphique

Ce chapitre présente quelques concepts et techniques de base concernant l’utilisation de votre ordinateur.

5.5.1. Le bureau Mandrake Linux

Tous les environnements graphiques modernes partagent un ensemble de fonctionnalités : menu principal,
surface de bureau et icônes, bandeau, etc. Nous décrivons dans les paragraphes qui suivent les éléments
constitutifs d’un environnement de bureau.

Figure 5-4. Le bureau KDE

1. Sur la gauche de l’écran se trouvent des icônes. Elles sont agrémentées d’un court texte (le titre ou le nom
de l’icône). En cliquant sur une icône, vous pourrez lancer un programme ou ouvrir un dossier. Dans les
deux cas une fenêtre apparaîtra sur le bureau.

2. En bas de l’écran figure le tableau de bord. Il permet d’accéder rapidement à certains outils comme le
Terminal , le système d’aide, etc. Chacune des icônes représente une application (ou un programme).
Déplacez le curseur de votre souris sur l’une d’elles et laissez le pointeur sur cette icône pendant quelques
secondes. Une bulle d’aide jaune apparaîtra. Elle décrit la fonction de l’icône.
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3. Les icônes et le tableau de bord ne flottent pas simplement sur l’écran : ils sont « accrochés » à quelque
chose, le « bureau », aussi appelé l’arrière-plan. D’une certaine façon, le bureau est le lieu où tout ce que
vous voyez ou utilisez vit. Portez votre curseur sur le bureau (c’est-à-dire, où il n’y a rien), et cliquez avec
le bouton droit de votre souris : une liste d’actions au sein d’un menu déroulant apparaîtra, donnant
accès à plusieurs fonctionnalités.

5.5.2. Accès aux logiciels

Comme il y a peu d’icônes sur le bureau ou sur le tableau de bord, peut-être vous demandez-vous comment
accéder à tous les programmes installés durant le processus d’installation. C’est très simple : sur la gauche du
tableau de bord se trouve une icône comme ceci :

Figure 5-5. Menu des logiciels sous KDE

Cliquez simplement sur cette icône et un menu déroulant (vers le haut cette fois) contenant vos logiciels
apparaîtra. Ils sont organisés par catégories donc il est aisé de trouver le logiciel que vous cherchez.

Pour lancer une application ou un outil, cliquez sur l’icône du menu principal, naviguez dans l’arborescence
jusqu’à l’entrée de menu cherchée et cliquez dessus. Si vous avez un doute quant au programme se trouvant
sous une entrée du menu, laissez le curseur immobile au dessus de celle-ci et un message d’aide apparaîtra.

5.5.3. Ouvrir une fenêtre sur le bureau

Si vous cliquez sur l’icône du bureau intitulée Dossier personnel de [votre_identi�ant], vous entendrez
votre disque dur s’agiter un peu. Puis cette fenêtre apparaîtra :

Figure 5-6. Gestionnaire de fichiers sous KDE

Vous venez de lancer un programme (ici, un gestionnaire de fichiers), qui a ouvert une fenêtre montrant
le contenu de votre dossier personnel. C’est le dossier où tous vos documents personnels et fichiers sont
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stockés : vous êtes le seul utilisateur pouvant y accéder. Si vous commencez à y enregistrer un grand nombre
de fichiers (textes, MP3, etc.) il est préférable de créer des sous-dossiers (en l’occurrence Documents, Musique,
etc.).

Une fenêtre se compose de différentes parties. Tout en haut figure la barre de titre : cette partie vous indique le
nom du programme que vous utilisez, et éventuellement, le document sur lequel vous travaillez. Cette barre
peux montrer deux états différents :

• actif, qui signifie que c’est la fenêtre que vous utilisez actuellement, ou

• inactif, qui signifie que le programme fonctionne toujours, mais que vous n’êtes pas en interaction avec
celui-ci.

En général, la barre de titre active est colorée, alors que la barre de titre inactive est grise ou estompée.

Juste sous la barre de titre, vous trouvez la barre de menu. Dans notre exemple, vous y trouvez (de gauche
à droite) Fichier, Édition, et ainsi de suite. Cliquez sur Fichier : une liste d’options apparaît, chacune vous
donnant accès à une fonction du programme.

Sous la barre de menu, vous trouvez la barre d’outils. C’est simplement une ou plusieurs lignes d’icônes,
chacune équivalant à une option dans un menu déroulant : vous pouvez les voir comme un accès rapide à
certaines fonctions du programme, que vous trouveriez également quelque part dans la barre de menu.

Dans le bas de la fenêtre réside souvent une barre d’état. À cet endroit, le programme affiche différentes
informations concernant son état, ou ce qu’il fait. Tous les programmes ne le proposent pas, mais si vous avez
une barre d’état, pensez à la consulter de temps en temps.

5.5.4. Gérer fenêtres et bureaux

Nous vous avons présenté le mot bureau pour désigner la zone de l’écran où tous les objets (panneau, icônes
fenêtres) sont placés. Maintenant, regardez la barre d’outils en bas de l’écran. Vous y voyez un groupe de
quatre boutons :

Figure 5-7. Boutons des bureaux virtuels de KDE

Ces boutons donnent accès à des « bureaux virtuels », identiques au premier bureau que vous avez vu en
vous connectant.

Cliquez sur celui intitulé 2 : vous constatez que la fenêtre que vous aviez ouverte disparaît, et que la couleur
de fond change. Vous n’avez pas fermé la fenêtre, vous avez simplement changé de bureau, comme si vous
changiez de table de travail.

Cliquez sur le bouton nommé 1, la fenêtre précédente revient : vous êtes de retour dans votre premier bureau.

Cette fonctionnalité, appelée bureaux virtuels (ou encore espace de travail), est très pratique : elle vous permet
d’ouvrir plusieurs fenêtres, et de les organiser comme vous voulez dans les différents bureaux.

Vous pouvez également déplacer une fenêtre d’un bureau virtuel à l’autre. Très utile, cette fonction permet
d’organiser logiquement votre travail par bureau, en déplaçant toutes les fenêtres en rapport avec Internet sur
le bureau 2, applications multimédia sur le bureau 3, etc.

Vous devrez utiliser votre souris à nouveau. Avec KDE , cliquez avec le bouton droit sur la barre de titre de la
fenêtre et un menu déroulant apparaîtra. Vous y verrez l’item Vers le bureau. Pointez simplement vers cet item
et une liste de vos bureaux virtuels sera affichée. Choisissez ensuite le bureau virtuel vers lequel vous voulez
déplacer la fenêtre.

Souvent, sans doute, vous trouverez que votre fenêtre est au bon endroit, mais qu’elle est trop grande ou trop
petite. Cliquez sur ce bouton de la barre de titres :
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Figure 5-8. Agrandir les fenêtres

Cette opération s’appelle agrandir ou maximiser une fenêtre. Cliquez de nouveau sur le même bouton pour
retrouver la taille initiale.

Au contraire, si vous voulez masquer votre fenêtre mais conserver le programme, cliquez sur ce bouton :

Figure 5-9. Réduire les fenêtres

La fenêtre semble disparaître. En fait, vous l’avez réduite à sa taille minimale : celle d’une icône. Cette opé-
ration s’appelle réduire ou minimiser une fenêtre : vous libérez l’espace d’affichage qu’elle utilisait, mais le
programme fonctionne toujours. Vous pouvez toujours le voir sur le panneau, dans la zone appelée barre des
tâches pour KDE :

Figure 5-10. La barre des tâches sous KDE

Pour restaurer la fenêtre, cliquez simplement sur l’icône associée.

Dans la plupart des cas, vous ne voulez ni agrandir ni réduire votre fenêtre. Vous voudrez une sorte
d’intermédiaire, où vous pouvez ajuster la taille de la fenêtre exactement selon vos besoins. Vous pouvez
faire cela avec votre souris, et l’un des bords de la fenêtre.

Placez le pointeur de la souris à la limite droite entre le bureau et le programme en fonctionnement :
votre pointeur se change en double-flèche. Maintenant, agissez comme pour déplacer une fenêtre :
pressez le bouton gauche, maintenez-le enfoncé tout en bougeant la souris. Vous pouvez voir la fe-

nêtre changer de taille, son contenu se réarranger. Lorsque vous êtes satisfait de la nouvelle taille, relâchez
simplement le bouton.

Nous avons effectué cela avec le bord droit de la fenêtre. Vous pouvez effectuer la même opération avec les
autres bords. Vous pouvez même utiliser les coins de fenêtre, et dans ce cas vous pouvez redimensionner la
fenêtre dans deux directions différentes.

Notez que toutes les fenêtres ne peuvent pas être dimensionnées à
nouveau de cette façon, et souvent, les tailles minimale et maximale
sont prédéfinies.

Dernière note à propos des boutons dans la barre de titre. Considérez celui-ci :
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Figure 5-11. Fermer une fenêtre

Si vous cliquez sur ce bouton, vous arrêtez le programme, tout simplement : vous le quittez. Il est appelé le
bouton de fermeture.

5.5.5. Personnalisez votre bureau

L’aspect général de votre environnement graphique peut être personnaliser selon vos goûts. Entre autres, vous
pouvez modifier le fond d’écran, les couleurs des fenêtres et d’arrière-fond, les « thèmes », la façon dont se
comportent les fenêtres et les icônes, etc.

5.6. Fermer votre session

Lorsque vous avez fini d’explorer votre environnement graphique, ou fini de travailler avec votre applica-
tion favorite, n’oubliez pas d’informer le système que vous partez, en somme, déconnectez-vous de manière
appropriée.

Vous pouvez vous déconnecter de plusieurs façons. Vous pouvez utiliser le menu principal, les icônes de dé-
connexion ainsi que cliquer avec le bouton droit pour obtenir des menus déroulants. Examinons ces différentes
procédures :

Sous KDE

• Avec le Menu K.

Cliquez sur le menu K et choisissez Quitter l'environnement. Une fenêtre comme celle affichée plus bas
apparaîtra et vous demandera de confirmer.

Figure 5-12. Confirmation de déconnexion sous KDE

• Cliquez avec le bouton droit sur le bureau

Vous pouvez cliquez avec le bouton droit sure un emplacement libre du bureau, et un menu déroulant
apparaîtra.
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Figure 5-13. Se déconnecter en utilisant le menu déroulant sous KDE

Cliquez simplement sur Déconnecter ... et la fenêtre de confirmation apparaîtra.

Quelle que soit la méthode que vous utiliserez, l’écran se grisera et une petite fenêtre apparaîtra proposant
plusieurs options (soit la « fenêtre de confirmation »). Si vous cliquez sur le bouton OK, l’action par défaut
sera appliquée : vous quitterez la session actuelle, et après que toutes vos fenêtres se soient fermées, l’écran de
connexion apparaîtra à nouveau.

Vous aurez toutefois remarqué que deux autres options sont disponibles dans la fenêtre de confirmation : vous
pouvez aussi choisir d’arrêter le système (Éteindre l'ordinateur), ou de le redémarrer (Redémarrer l'ordinateur).
Cochez l’option désirée et cliquez sur le bouton OK.

Quel que soit votre choix, ceci est la manière correcte et sûre pour arrêter ou redémarrer votre machine quitter.
Vous ne devriez jamais vous contenter de presser l’interrupteur de l’ordinateur car cela pourrait causer des
problèmes au système de fichiers et entraîner la perte de données.
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Outre ce manuel et le manuel de référence, vous disposez de nombreuses sources de documentation, soit à
même votre distribution, soit sur Internet. Dans ce chapitre, vous trouverez un inventaire aussi complet que
possible des sources à consulter en cas de besoin.

6.1. La documentation fournie avec Mandrake Linux

6.1.1. La documentation de MandrakeSoft

6.1.2. Les pages de manuel

C’est sans doute la source d’information principale au quotidien. Pratiquement toutes les commandes ont leur
page de manuel (man page, et il y a aussi des pages de manuel sur le format de certains fichiers de configuration,
sur les fonctions de bibliothèques (en anglais, library) pour les programmeurs, et d’autres encore. Une grande
partie des pages de manuel existent en français, mais malheureusement pas toutes.

Le contenu des pages de manuel est organisé en différentes sections. Plusieurs références aux dites sections
sont faites de la manière suivante : open(2), fstab(5) réfèrent respectivement à la section 2 de la page de manuel
open et à la section 5 de la page de manuel fstab.

La commande pour afficher une page de manuel est man, et sa syntaxe est la suivante :

man [options] [section] <page de manuel>

Il y a même une page de manuel pour man, soit man man. Elles sont pré-formatées puis affichées avec un pager
(ou visionneuse) less est utilisée par défaut. Donc, vous savez déjà comment parcourir une page de manuel
et la quitter :-)

Les noms des pages de manuel et de leurs sections relatives apparaissent au haut de chacune des pages. En
bas de ces pages (en général dans la section VOIR AUSSI ou SEE ALSO pour les pages de manuel qui ne sont
pas encore francisées) pointent vers d’autres pages de manuel, et traitent de sujets connexes à ceux de la page
que vous consultez.

Vous pouvez commencer par consulter les pages de manuel des différentes commandes qui ont été abordées
dans ce manuel : ls(1), chmod(1), etc.

Si vous ne tombez pas sur la bonne page de manuel –– par exemple vous voulez utiliser la fonction mknod
dans un de vos programmes mais ouvrez sur la page de manuel de la commande mknod, il vous faut expliciter
la section :mknod(2) en l’occurrence, ou si vous ne vous souvenez plus de la section exacte, man -a mknod, qui
parcourra toutes les sections à la recherche de pages de manuel ayant pour nom mknod.

6.1.3. Les pages info

Les pages info sont une autre source de documentation, plus complète que les pages de manuel. La com-
mande pour les consulter est info.

Elles sont organisées sous forme d’arborescence dont le sommet s’appelle dir. À partir de là, vous pouvez
accéder à toutes les pages info existantes.

Vous pouvez accéder aux pages info de deux façons : soit sans aucun argument. Ainsi, vous vous retrouverez
au sommet de l’arborescence. Si vous y rajoutez un nom de commande ou de paquetage, la page correspon-
dante, si elle existe, sera ouverte. Par exemple :

info emacs

Malheureusement toutes les pages d’info sont pour l’instant en anglais. Dans les pages info, un texte similaire
à :

* Buffers::

indique un lien. Si vous placez le curseur sur ce lien (à l’aide des touches fléchées) et appuyez sur la touche
Entrée, vous serez alors amené à la page info correspondante.
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Les raccourcis clavier suivants existent :

• u : pour Up (haut), monte au niveau supérieur ;

• n : pour Next (prochain), va à la page info suivante dans ce niveau de l’arborescence ;

• p : pour Prev (précédent), va à la page info précédente.

• q : pour Quitter, termine le visualiseur info.

Les commandes sont nombreuses, vous pouvez taper ? pour en obtenir la liste.

6.1.4. Les HOWTOs

Les HOWTOs (ou « comment faire ») sont édités par le TLDP (The Linux Documentation Project, Le projet de
documentation Linux) et sont dédiés à la configuration de nombreux aspects de votre système. Si le bon pa-
quetage est installé (il s’agit des paquetages howto-html-en et howto-html-fr pour les éditions anglaise et
française respectivement), ces HOWTOs procurent des réponses ou solutions spécifiques à des problèmes re-
liés à votre système. Cette documentation se trouve dans le répertoire /usr/doc/HOWTO/HTML/fr/ pour la ver-
sion française. Ce sont des fichiers HTML consultables et imprimables à partir de n’importe quel navigateur
Web.

La liste est très longue : pour vous en convaincre, consultez l’index à partir du menu principal de votre gestion-
naire de fenêtres : Documentez-vous→Howto en français. Si vous tombez sur un problème que vous n’arrivez
pas à résoudre, trouver le HOWTO correspondant s’il existe ; le lire est le meilleur point de départ, et il est
très probable que vous y trouverez la solution d’une part. Aussi, vous apprendrez beaucoup de choses en le
lisant. Entre autres sujets sont couverts le réseau (NET-3-HOWTO), la configuration de cartes son (Sound-HOWTO),
comment graver un CD (CD-Writing-HOWTO), la configuration de NIS et NFS, ainsi que plusieurs autres sujets.

Il faut cependant faire attention aux dates de dernière modification des HOWTOs : certains n’ont pas été mis
à jour depuis des lustres. Conséquemment, il est probable que leur contenu ne soit plus valide. Donc, méfiez-
vous des vieux HOWTOs traitant particulièrement de configuration matérielle puisque GNU/Linux évolue très
vite. Souvenez-vous aussi que le qualificatif « ancien » dans le mode du logiciel libre est encore plus significatif
qu’en informatique en général : un logiciel libre vieux de quinze jours est parfois considéré comme ancien,
voire périmé !

Les HOWTOs sont disponibles en ligne sur le site du TLDP
(http://fr.tldp.org/) et susceptibles d’y être légèrement plus
à jour. Consultez aussi lesHOWTOs (http://fr.tldp.org/
howtos.php) ; et questions fréquentes (FAQs (http://tldp.org/
docs.html)) en anglais.

6.1.5. Le répertoire /usr/doc

Quelques paquetages viennent également avec leur propre documentation, Ils sont placés dans un sous-
répertoire de /usr/doc et leur nom est souvent celui du paquetage. Malheureusement, cette documentation
est souvent en anglais et n’est pas traduite.

6.2. Internet

Les sources de renseignements sur Internet sont très nombreuses. Les sites Web dédiés à GNU/Linux et à son
utilisation ou sa configuration sont abondants. Mais il n’y a pas que les sites Web.

Votre source d’information privilégiée à propos de Mandrake Linux devrait être le site officiel de Mandrake
Linux (http://mandrakelinux.com/). Consultez en particulier la section support (http://mandrakeexpert.
com).
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6.2.1. Les sites Internet dédiés à GNU/Linux

6.2.1.1. MandrakeClub

Si vous êtes familiers avec les sites de Mandrake Linux, vous con-
naissez sûrement Mandrake Club (http://mandrakeclub.com/).
C’est le point de rencontre de tous les utilisateurs de Mandrake Li-
nux. Vous y trouverez des suggestions, des questions ainsi que des
nouvelles relatives à Mandrake Linux et GNU/Linux . Vous pourrez
y exprimer votre opinion et influencer les développements futurs de
Mandrake Linux. Si vous n’êtes pas encore membre, allez-y, les
avantages sont immenses.

6.2.1.2. Démos et tutoriels

Une section du site Web Mandrake Linux (http://www.mandrakelinux.com/) est consacrée aux démos
et tutoriels (http://www.mandrakelinux.com/en/demos/). Entre autres sujets, sont discutés l’installation et
l’environnement graphique ; des tutoriels sur plusieurs aspects de la configuration de votre système : réseau,
entretien des paquetages, configuration serveur, etc. Vous pouvez accéder à certains de ces tutoriels depuis le
CD d’installation du répertoire tutoriels.

6.2.1.3. Sites Web traitant de la sécurité

MandrakeSecure (http://www.mandrakesecure.net/)

Le site de sécurité de MandrakeSoft couvrant les vulnérabilités récentes des paquetage, mais surtout de
longs articles couvrant de vastes sujets relatifs à la sécurité.

Security Focus (http://www.securityfocus.com/)

Un site très bien organisé qui passe en revue les attaques à la mode, et donne des alertes de vulnérabilité
pour un nombre impressionnant de produits, y compris Mandrake Linux.

Linux Security (http://www.linuxsecurity.com/)

Celui-ci est entièrement dévoué à GNU/Linux et présente des nouvelles, alertes, lettres d’information, et
de nombreuses autres ressources telles que de la documentation, des forums, des outils, etc. Jetez un coup
d’oeil à la page documentation (http://www.linuxsecurity.com/docs) du site.

Linux point com (http://www.linux.com/index.pl?section=documentation)

Un excellent site régulièrement alimenté de nombreux articles traitant de problèmes de sécurité actuels.
cette section de Linux.com (http://linux.com/) aborde également d’autres sujets, comme ceux du bu-
reau, du son, etc.

6.2.1.4. Autres sites dédiés à GNU/Linux

Parmi la multitude des sites Web existants, voici quelques-uns des plus complets :

Linux Point Org (http://www.linux.org/)

Un des premiers sites dédiés à Linux qui contient une foule de liens vers des sites très pertinents.

Freshmeat (http://freshmeat.net/)

C’est l’endroit à visiter pour obtenir les plus récentes applications disponibles sous Linux.

Linux France (http://www.linux-france.org/article/)

Site Web abritant de la documentation, souvent écrite par les collaborateurs du site.
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Freenix (http://www.freenix.org/unix/linux/)

Encore de la documentation.

Université de Nancy (http://uhp.u-nancy.fr/linux/)

Toujours de la documentation !

Linux Weekly News (http://www.lwn.net/)

Cela est sans doute la publication Linux la plus exhaustive. Elle couvre tout, depuis la dernière alerte
de sécurité aux nouvelles distributions, des infos sur le dernier noyau et les autres, des bouquins, et une
lettre d’informations hebdomadaire.

Et bien sûr, n’oubliez pas votre moteur de recherche favori. De manière générale, c’est même l’outil le plus ef-
ficace. Quelques mots-clés bien choisis dans un moteur de recherche vous donnent souvent des liens vers
des pages traitant de votre problème particulier. Malheureusement pour les unilingues francophones, la
documentation en anglais est beaucoup plus étoffée. Néanmoins, le site du TLDP (http://fr.tldp.org/)
est proposé en français. De même, le site Google (http://www.google.fr/), que vous pouvez parcourir en
français, vous permettra de faire une recherche plus ciblée en ce qui a trait au monde GNU/Linux (http:
//www.google.fr/linux).

6.2.2. Listes de diffusion (Mailing Lists)

Les listes de diffusions sont toujours très populaires, malgré la multiplication des autres moyens de commu-
nication. Presque tout programme sous GNU/Linux possède ses propres listes de diffusion orientées vers les
utilisateurs, les programmeurs, les annonces etc.

Le projet Mandrake Linux possède ses propres listes de support (http://www.mandrakelinux.com/fr/
flists.php3).

Nous ne pouvons pas donner ici une liste d’adresses exhaustives, mais gardez à l’esprit que c’est bien souvent
le meilleur moyen de garder le contact avec les meilleurs experts sur un sujet particulier. Quelques conseils
pour finir :

• Ne pas poser de question hors sujet. Lisez avec soin les directives généralement envoyées lors de votre
inscription à la liste ou sur la page Web de la liste. Il est aussi recommandé de lire cette version du E-
mail Étiquette (http://www.iwillfollow.com/email.htm), qui contient de précieux conseils. Si vous avez
du temps libre, vous pouvez aussi lire les RFC (http://www.rfc-editor.org/)s.

IMPORTANT: prenez soin d’archiver le premier e-mail que vous
recevez de la liste car il contient souvent des renseignements utiles,
et notamment la procédure pour se désabonner.

• Respectez les règles générales applicables au courrier électronique. En particulier, n’envoyez jamais de mes-
sages en HTML : texte seulement.

• Les listes de diffusion ont généralement des archives : consultez-les ! Votre question peut avoir été débattue
juste avant que vous ne vous abonniez...

6.2.3. Les forums de discussion

Pour obtenir de l’aide sur les news, vous devez d’abord rechercher si votre problème n’a pas déjà été abor-
dé (voire résolu) sur le site Web dejanews (http://groups.google.com/googlegroups/deja_announcement.
html), lequel a été racheté par Google. Si vous ne trouvez rien, il existe un forum de discussions entièrement
consacré à Mandrake Linux: mandrake news (news:alt.os.linux.mandrake). Vous avez également à votre
disposition deux groupes dans la « hiérarchie » des groupes de discussion fr.comp.os.linux.* :

• Linux configuration (news:fr.comp.os.linux.configuration) : questions au sujet de la configuration de
GNU/Linux (périphériques, applications) et résolution de problèmes divers ;
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• Linux moderated (news:fr.comp.os.linux.moderated): questions relatives à l’utilisation et à la configura-
tion de GNU/Linux , groupe « modéré » (assez haut niveau) ;

• et bien d’autres...

Avant de publier une question dans l’un de ces groupes, assurez-vous d’avoir lu (et digéré) le maximum
de documentation que vous ayez pu trouver sur votre problème ! Lorsque les habitués de ces groupes voient
qu’une nouvelle personne pose une question sans avoir lu suffisamment, ces nouvelles personnes le regrettent
en général amèrement... car les premières réponses qu’on leur donne se résument à « lis la doc et reviens
après ». Et surtout, surtout, ne posez aucune question concernant la configuration sur le groupe de discussion
fr.comp.os.linux.debats (news:fr.comp.os.linux.debats) ! Ce n’est pas le sujet du groupe...

6.3. Comment résoudre un problème sous Mandrake Linux

Nous passons en revue ici les différents moyens à votre disposition pour résoudre un problème particulier.
Pour commencer, essayez la premier proposition, si ça ne marche pas, la deuxième et ainsi de suite.

6.3.1. Chercher sur Internet

Les nombreux sites Web susmentionnés sont d’excellents points de départ. Ils peuvent aborder de près comme
de loin plusieurs aspects de votre problème. Finalement, essayez un moteur de recherche généraliste comme
Google (http://www.google.com) ou Google/Linux (http://www.google.com/linux). Et n’hésitez pas à uti-
liser l’option Recherche avancée (http://www.google.com/advanced_search) avec des questions très dé-
taillées comme le message d’erreur que vous avez.

6.3.2. Archives de listes de diffusion et de forums

Les recherches sur Internet donnent de nombreuses réponses cachant une réponse intéressante parmi de nom-
breuses autres. Pour raffiner votre recherche, voici ce qui peut-être entrepris :

Pour commencer, essayez de trouver une liste qui semble être directement liée à votre problème, puis lancez
une recherche parmi ses archives.

Exemple
Vous avez remarqué un comportement étrange en utilisant GRUB avec une partition minix .

Une recherche en utilisant les mots clé « grub mailing list » sur Google donne dans ses premiers résultats le lien
vers un message d’archive de la liste GRUB mailing-list July 1999 (http://mail.gnu.org/pipermail/bug-grub/
1999-July/003129.html). Une fois là, vous obtenez l’URL de la liste : GRUB mailing list archive (http://www.
mail-archive.com/bug-grub%40gnu.org/). Cette archive propose même un moteur de recherche. De fait, en cher-
chant sur « Minix », vous trouverez directement une solution.

Notez toutefois que peu d’archives proposent un moteur de recherche intégré. Il suffit alors d’utiliser le champs
domaine pour limiter vos recherches au site hébergeant les archives. Cette stratégie peut aussi être utilisée pour les
sites qui renvoient régulièrement des réponses sans rapport.

Pour une recherche sur les forums, dejanews (http://groups.google.com/googlegroups/deja_announcement.
html) contient des archives pour une quantité impressionnante de forums de discussion.
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6.3.3. Questions aux listes de diffusion et forums

Voir les sections susmentionnées : Listes de diffusion (Mailing Lists), page 46 et Les forums de discussion,
page 46. Lisez également Comment Poser Les Questions De Manière Intelligente (http://www.gnurou.org/
smart-questions-fr.html).

6.3.4. Contacter directement la personne responsable du projet

Utilisez cette option en tout dernier recours et en situation désespérée – à moins que vous ne vouliez offrir
votre aide ; les programmeurs reçoivent généralement beaucoup de courrier électronique. Ainsi, votre ques-
tion polémique sur l’utilisation de la commande cd sera probablement... ignorée !

Les adresses se trouvent soient sur la page du projet ou dans leur propre documentation.

C’est tout pour l’instant ! Un dernier mot toutefois : ne sous-estimez pas les capacités de votre voisin ou de
votre LUG (groupe d’utilisateurs Linux) local. Et, s’il vous plaît, ne jetez pas votre ordinateur par la fenêtre :
si votre problème n’est pas résolu aujourd’hui, il le sera sûrement demain...

6.3.5. Services professionnels Mandrake

Enfin, face à un défi complexe, les utilisateurs professionnels pourront faire appel à un consultant de Mandra-
keSoft pour s’occuper de leurs besoins spécifiques.

Voilà réellement une des caractéristiques les plus fortes des produits libres : Nous avons les sources, nous
avons la puissance ! Ainsi, tout problème, quel que soit sa complexité, son niveau élevé ou spécifique, peut
sans doute être résolu, directement au coeur du logiciel.

Vous pouvez aussi souhaiter personnaliser votre environnement Linux pour atteindre des buts spécifiques.
Vous voudrez par exemple utiliser Mandrake Linux comme application de routage spécialisée sur un péri-
phérique particulier. Sachez alors que les MandrakeSoft services professionnels (http://www.mandrakesoft.
com/products/business) peuvent vous aider.
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7.1. Découvrir l’environnement KDE (K Desktop Environment)

Ce chapitre se veut une introduction à l’environnement KDE et à son tableau de bord. Il traitera également
du concept de bureau virtuel (comment les gérer et y naviguer aisément). Il discutera également du système
d’aide KDE et du concept de session. La large palette de fonctionnalités que KDE offre ainsi que ses possibilités
de personnalisation sont immenses et vous êtes encouragés à consulter Système d’aide de KDE, page 53 afin
d’en apprendre plus sur cet environnement de premier plan.

7.1.1. Le bureau

Figure 7-1. Le bureau KDE

KDE respecte le paradigme des bureaux modernes. La figure suivante montre le bureau avec quelques icônes,
et le tableau de bord en bas. Cependant, il présente une nouveauté pour les habitués du monde Windows : les
bureaux virtuels (voir Bureaux virtuels, page 50)

Les bureaux virtuels ne sont pas un concept spécifique à KDE . GNOME
les gère également (cf ), ainsi que d’autres environnements graphi-
ques et gestionnaires de fenêtres GNU/Linux .

Le bureau contient des icônes qui représentent des fichiers, des répertoires, des applications, des périphé-
riques, des pages Web (en fait, l’adresse desdites pages), etc. Quasiment « tout » peut être placé sur le bu-
reau. Différentes actions sont associées aux icônes selon leur nature, par exemple : cliquer sur un fichier texte
l’ouvrira dans un éditeur de texte, cliquer sur une page Web ouvrira son URL dans Konqueror (voir Gestion-
naire de fichier : Konqueror, page 55), et ainsi de suite.

Le tableau suivant présente quelques-unes des icônes que vous verrez sur votre bureau, agrémentée d’une
courte définition pour chacune d’entre elles.

Dossier personnel. Donne accès à vos fichiers personnels. Dans les systèmes d’exploitations de type
UNIX (GNU/Linux étant l’un d’entre eux), chaque utilisateur possède un répertoire personnel généralement
appelé /home/nom_de_connexion où nom_de_connexion est le nom de connexion de l’utilisateur.
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Corbeille. Donne accès aux fichiers effacés (l’équivalent de la corbeille de Windows ). Sachez qu’il
est possible d’effacer directement un fichier sans qu’il ne passe par la corbeille. Donc, certains fichiers effacés
peuvent ne pas être accessibles par l’entremise de la corbeille.

Médium amovible. Ouvre une fenêtre Konqueror montrant les icônes représentant les médias amo-
vibles de votre système (lecteur CD-ROM, lecteur de disquette, lecteur ZIP/JAZ, etc.). En cliquant sur une des
icônes associées à un périphérique, vous ouvrirez le médium relié à ce dernier. Un message d’erreur peut éga-
lement s’afficher si aucun médium n’est présent ou si le médium ne peut être lu, pour une raison quelconque.

7.1.2. Le tableau de bord

Figure 7-2. Le tableau de bord KDE

Le tableau de bord est la barre sise au bas du bureau1 et contient les composants principaux suivants :

Le menu principal. Donne accès à tous les logiciels installés sur le système. Il s’agit de l’équivalent
du menu Démarrer de Windows . Les logiciels sont triés par catégorie de façon a ce que l’on puisse facilement
trouver l’application voulue.

Afficher le bureau. Utiliser cette icône permet de minimiser toutes les fenêtres actuellement ou-
vertes. Cliquer dessus une deuxième fois permet de retrouver les fenêtres à leur position précédente. Cette
fonctionnalité est très pratique quand le bureau est surchargé de fenêtres ouvertes et que l’on veut, par exem-
ple, accéder à une icône du bureau.

Dossier personnel. Cette icône a la même fonction que celle représentant le dossier personnel sur
le bureau. Elle ouvre Konqueror sur votre répertoire personnel, de façon à pouvoir consulter et gérer vos
documents et dossiers personnels.

Barre de sélection de bureau. Permet de passer facilement d’un bureau virtuel à l’autre. Voir Bureaux
virtuels, page 50 pour plus de renseignements.

Klipper. Donne accès au presse-papiers. C’est un espace de stockage temporaire pour tous les objets
(texte, images, etc.) que vous copiez depuis les applications (via l’entrée Copier du menu Éditer). Klipper
permet de naviguer et de manipuler les différents objets copiés dans le presse-papiers.

7.1.3. Bureaux virtuels

Les bureaux virtuels vous donnent plus d’espace pour placer vos fenêtres de travail ; ils vous permettent
également d’organiser vos fenêtres par tâches (travail, jeux, internet, etc.).

On peut comparer les bureaux virtuels à différents écrans disponibles, mais avec un seul moniteur. Quatre
bureaux sont disponibles par défaut. Pour ajouter ou enlever des bureaux virtuels, il suffit de cliquer avec le
bouton droit sur la barre de sélection de bureau et de sélectionner Con�gurer les bureaux virtuels... depuis
le menu déroulant. En utilisant le curseur situé en haut de la fenêtre de paramétrage, de un à seize bureaux
virtuels peuvent être activés. Cliquez sur OK une fois que vous êtes satisfait de vos paramétrages.

Par défaut, les bureaux virtuels sont nommés bureau N, où N est le numéro du bureau. Afin de donner des
noms plus significatifs à vos bureaux virtuels, cliquez avec le bouton droit sur la barre de sélection de bureau

1. Par défaut, le tableau de bord est placé en bas, mais il peut être placé sur n’importe lequel des bords du bureau.
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et en sélectionner Con�gurer les bureaux virtuels... dans le menu déroulant. Cliquez sur la zone d’entrée du
bureau que vous voulez renommer et entrez le nouveau nom. Cliquez sur Appliquer afin que les changements
s’appliquent immédiatement. Appuyez sur OK une fois que vous êtes satisfait de vos paramétrages.

Le premier bureau virtuel est celui ouvert par défaut quand vous vous connectez dans KDE . Pour changer de
bureau virtuel, il suffit de cliquer sur le nom du nouveau bureau dans la barre de sélection de bureau et voilà !

7.2. Personnaliser le bureau

7.2.1. Modifier l’apparence du bureau

Figure 7-3. Modifier le modèle de couleurs KDE

Pour modifier le modèle des couleurs du bureau, choisissez Administrez votre système→Con�gurer votre bu-
reau depuis le menu principal. Choisissez alors Apparence (LookNFeel)→Couleurs dans le centre de contrôle
qui apparaît. Dans la liste Modèles de couleurs qui affiche les modèles prédéfinis, sélectionnez celui que vous
désirez puis cliquez sur Appliquer.

Il est possible de créer un modèle de couleurs personnel en cliquant sur l’élément dont vous voulez changer la
couleur (par exemple, sur Fenêtre Active pour changer les couleurs de la fenêtre active) ou en le sélectionnant
dans le menu déroulant Couleur des widgets. Une fois l’élément (widget) sélectionné, cliquer sur la barre de
couleur ouvrira la boîte de dialogue de sélection des couleurs, dans laquelle il suffit de sélectionner la couleur
puis de cliquer sur OK afin d’appliquer cette couleur à l’élément choisi.

Cliquer sur Enregistrer le modèle... permet de sauvegarder le modèle pour une réutilisation ultérieure ; le nom
du modèle vous sera demandé. Une fois celui-ci rempli, il suffit de cliquer sur OK. Cliquer sur Supprimer le
modèle détruit le modèle de couleurs sélectionné.

Aucune confirmation n’est nécessaire pour détruire un modèle de
couleurs, aussi n’utilisez le bouton Supprimer le modèle qu’avec
précaution.
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Figure 7-4. Changer le fond d’écran de KDE

Pour modifier le fond d’écran du bureau, choisissez Administrez votre système→Con�gurer votre bureau de-
puis le menu principal . Dans le centre de contrôle qui apparaît, sélectionnez Apparence (LookNFeel)→Fond
d'écran. L’onglet Fond d'écran permet de changer la couleur de fond d’écran : la liste déroulante Mode permet
de sélectionner parmi diverses utilisations des couleurs, de la simple couleur unie (fond peint d’une seule
couleur) à divers types de dégradés de couleurs (Dégradé vertical, par exemple).

L’onglet Papier peint permet d’utiliser une image comme fond d’écran : le menu déroulant Mode permet de
spécifier si l’image doit être agrandie, changée d’échelle, centrée, etc. La liste déroulante Papier peint permet
de sélectionner l’une des images de fond d’écran prédéfinie ; il suffit de cliquer sur le bouton Parcourir pour
sélectionner une image de votre cru via la boîte de dialogue de sélection de fichiers de KDE .

Enfin, l’onglet Avancé donne accès aux fonctionnalités avancées telles que l’activation de la transparence, la
taille de la mémoire cache réservée aux images, etc.

Tous les paramétrages de fond d’écran de bureau peuvent
s’appliquer uniquement au bureau courant. Pour ce faire, décochez
la case à cocher Fond d'écran commun à tous les bureaux et sé-
lectionnez le bureau auquel appliquer les changements. Toutefois,
cette option nécessite plus de mémoire.

7.2.2. Gérer les icônes du bureau

Ajouter des icônes. Cliquer avec le bouton droit de la souris sur le fond du bureau et choisissez Créer un
nouveau... Dans le sous-menu, choisissez le type d’objet à créer sur le bureau :

• Dossier... crée un nouveau dossier sur le bureau où il est possible de stocker des fichiers.

• Lien vers une application... crée un « lanceur » d’application. Lorsque l’on clique dessus, l’application sera
lancée comme si elle l’avait été depuis un menu ou la ligne de commande. Cette fonctionnalité est très
pratique pour créer des raccourcis rapides vers les applications les plus utilisées.

• Lien vers une URL... crée une icône qui donne directement accès à l’URL (généralement une page ou un site
Web). Cette fonctionnalité est très pratique pour créer des raccourcis rapides vers vos sites favoris sur votre
bureau.
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La liste ci-dessus n’est pas exhaustive. En fait, les différentes pos-
sibilités offertes par ce menu dépendent des logiciels installés sur
votre système.

Veuillez garder à l’esprit que les formulaires qu’il faut remplir afin d’ajouter une application varient selon le
type d’objet à créer. Leurs options sont cependant fort simples.

Modifier les icônes. Cliquer avec le bouton droit de la souris sur l’icône que l’on désire modifier et sélectionner
Propriétés dans le menu déroulant qui apparaît. Une boite de dialogue s’ouvre alors et permet de modifier le
titre (la chaîne de caractères affichée sous l’icône), l’image de l’icône, et d’autres propriétés qui dépendent
du type de l’objet (dossier, application, URL, etc.). Une fois que les différentes modifications désirées ont été
effectuées, il suffit de cliquer sur OK afin de les appliquer.

Enlever des icônes. Pour enlever une icône, il suffit de cliquer avec le bouton droit de la souris sur celle-ci,
puis de sélectionner l’item Supprimer pour l’effacer définitivement ou Mettre à la corbeille pour la déplacer
dans la poubelle (d’où elle peut être restaurée plus tard en cas de regrets). Dans tous les cas, l’action ne sera
effectuée qu’une fois confirmée.

7.3. Système d’aide de KDE

Vous pouvez consulter toute la documentation de KDE et d’autres sources d’information sur le système grâce
au centre d’aide de KDE . Vous pouvez afficher le système d’aide en ouvrant le menu principal : Lire la
documentation→Lire la documentation de KDE.

Figure 7-5. Fenêtre principale du Centre d’aide de KDE

Le Centre de Contrôle de KDE est le système d’aide intégré de KDE . Il peut afficher les pages d’aide au for-
mat HTML, les pages du manuel UNIX , les pages au format Info et les catalogues Scrollkeeper2. Il est organisé
comme une « page Web » de deux cadres, celle de gauche contenant la liste des catégories représentées sous
forme d’un arbre, celle de droite affichant le contenu de la catégorie actuellement sélectionnée.

Les boutons de navigation sont semblables à ceux du navigateur Konqueror

Début. Retourne à la page d’accueil du centre d’aide, soit la page d’index. Raccourci clavier : Ctrl-
Home.

Précédent. « Retourne en arrière » à l’article de l’aide précédemment affiché. Raccourci clavier :
Alt-Flèche_gauche.

Suivant. Va « vers l’avant » dans l’historique de sites et de sujets du centre d’aide. Raccourci clavier :
Alt-Flèche_droite.

2. Scrollkeeper est un Projet libre de Catalogue de Documentations (http://scrollkeeper.sourceforge.net)
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Imprimer. Imprime l’article de l’aide actuellement affiché. Raccourci clavier : Ctrl-P

Vous devriez aussi consulter le site Web de KDE (http://kde.
org/documentation/) où vous pourrez trouver une somme im-
portante de documents pour vous aider à découvrir et mâıtriser
l’environnement de bureau K.

7.4. Sessions KDE

KDE et ses applications prennent en charge les sessions. Cette très agréable fonctionnalité permet au système
de restaurer toutes les applications qui étaient en fonction lorsqu’un utilisateur donné s’est déconnecté de
l’environnement graphique.

Gardez à l’esprit que les applications non spécifiques à KDE , et
même quelques applications KDE ont une prise en charge des ses-
sions limitée. Aussi, le degré de recouvrement de session dépend
du programmeur, allant de la simple réouverture d’une application,
jusqu’à la réouverture de l’application ainsi que des fichiers ouverts
à l’intérieur de cette application.

Par défaut, KDE sauvegarde automatiquement les sessions lorsque vous vous déconnectez de l’environnement
graphique. Pour changer ce comportement, ouvrez le Gestionnaire de session (Administrez votre système→
Con�gurez votre bureau depuis le menu principal. Dans le centre de contrôle qui apparaît, sélectionnez
Composants→Gestionnaire de session.), faites vos choix et cliquez sur Appliquer. les changements seront effec-
tifs la prochaine fois que vous vous connecterez sous KDE .

54

http://kde.org/documentation/
http://kde.org/documentation/


Chapitre 8. Konqueror

8.1. Gestionnaire de fichier : Konqueror

Les gestionnaires de fichiers sont devenus des applications multitâches, qui ne s’occupent plus simplement
de copier ou déplacer des fichiers. En effet, avec Konqueror , vous pourrez naviguer dans votre réseau local,
jouer des pistes audio telles que les Ogg Vorbis, naviguer sur le Web, et plus encore.

Dans ce chapitre, nous prenons pour acquis que vous avez déjà utilisé une telle application, et qu’il n’est
pas nécessaire de décrire des fonctions qui parlent d’elles-mêmes. Nous avons également décidé de parler de
Konqueror qui est le gestionnaire de fichier attitré de KDE .

8.1.1. Fenêtre principale

Vous accéderez à votre gestionnaire de fichiers en cliquant sur l’icône Répertoire perso située en haut à gauche
de votre bureau.

Figure 8-1. Konqueror

La partie à droite de la fenêtre affiche le contenu des répertoires (par défaut, votre répertoire personnel). À
gauche de la fenêtre se trouve le panneau latéral (référez-vous à Panneaux latéraux, page 55). Chaque fichier ou
sous-répertoire est représenté par une icône, quoique vous puissiez changer ce type d’affichage en changeant
le Mode d'a�chage dans Konqueror à travers le menu A�chage.

La première fois que vous lancerez Konqueror vous ne verrez pas la
barre latérale. Pour l’afficher, sélectionnez Fenêtre+A�cher Pan-
neau de navigation. Vous pouvez aussi afficher ou cacher cette
dernière à l’aide de la touche F9.

8.1.2. Panneaux latéraux

Voici quelques définitions sommaires des icônes du panneau latéral de Konqueror (;a Barre d,outils supplé-
mentaires à la quelle vous pouvez accéder à travers le menu Con�guration+Barres d'outils :

Icône Signification
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Icône Signification

Afficher Panneau de navigation. Permet de changer le mode d’affichage du panneau
latéral.

Signets. Où vous pouvez stocker vos sites Web et FTP préférés.

Historique. Montre la liste des répertoires et des sites réseau (Web, FTP, etc.) que vous
avez visités durant la session courante.

Répertoire personnel. Votre répertoire personnel, dans lequel vous pouvez organiser
vos fichiers.

Réseau. Vous donne accès aux archives de sites FTP ainsi qu’à des sites Web
spécifiques à Mandrake (bien entendu, vous pouvez ajouter ou supprimer certains
sites).

Répertoire racine (root). Vous donne accès à l’intégralité de votre arborescence. De
manière générale, vous n’avez pas le droit de manipuler les fichiers à l’extérieur de
votre répertoire personnel. Seulement l’administrateur système (root) possède ces
droits.

Services. Vous donne accès au Navigateur de CD Audio, le Navigateur de LAN et le
Navigateur de système d'impression.

Tableau 8-1. Icônes du panneau latéral de Konqueror

8.1.3. Copier, déplacer, supprimer et créer un lien vers un fichier

Copier des fichiers. Imaginons que vous vouliez copier le fichier test.png dans le répertoire Documents.
Avec Konqueror , vous devez premièrement accéder au menu Fenêtre→Diviser l'a�chage gauche/droite (ou
cliquez sur les touches Ctrl-Shift-L) ou le menu Fenêtre→Diviser l'a�chage haut/bas (ou appuyez sur les
touches Ctrl-Shift-T). Votre fenêtre sera dédoublée et il vous sera facile de déplacer l’image test.png dans
le répertoire Documents au moyen de la technique drag’n’drop. Notez que vous devez appuyer sur la touche
Ctrl pour copier un fichier.La façon la plus facile demeure la technique du drag’n’drop.

Il existe plusieurs façons pour manipuler des fichiers dans un ges-
tionnaires de fichiers. Drag’n’drop, combinaisons de raccourcis cla-
vier, ouvrir deux gestionnaires, etc. Choisissez celle que vous préfé-
rez.

Déplacer des fichiers. Le même principe s’applique pour déplacer des fichiers. Toutefois, pour ce faire, utilisez
le raccourci Ctrl-X au lieu de Ctrl-C. La technique drag’n’drop, sans appuyer sur la touche Ctrl, déplacera
également vos fichiers.

Créer un lien vers un fichier. Créer un lien vers un fichier permet d’accéder aux fichiers sans avoir à les copier
à divers endroits dans votre répertoire personnel. Imaginons qu’un de vos fichiers soit « enterré » dans le
répertoire /home/reine/Music/Artistes/ArtistePréféré/ et que vous vouliez y accéder rapidement. Créer
un lien vers ce répertoire serait une excellente idée. En effet, l’action de créer un lien équivaut à l’idée de
raccourci. Voici comment procéder. Avec Konqueror l’opération est différente :

1. Déplacez l’objet que vous voulez lier sur le dossier dans lequel vous voulez créer le lien et maintenez le
bouton de la souris enfoncé.

2. Pressez la touche Alt.

3. Relâchez le bouton de la souris, puis la touche Alt.

4. Dan le menu qui apparaît, Cliquez sur Lier ici.

Supprimer des fichiers. Comme pour toutes les opérations susmentionnées, il existe plusieurs façons de
supprimer des fichiers. Résumons en disons qu’il existe une façon « sécuritaire » et une autre, « dangereuse ».
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La première serait de déplacer l’item voulu dans la Corbeille, tandis que la façon dangereuse consisterait à
supprimer immédiatement l’item et vous rendrait incapable de le récupérer. L’action de supprimer un fichier
le déplacera, en fait, dans la Corbeille. Pour le récupérer, double-cliquez sur l’icône de la Corbeille sur votre
bureau et déplacez le fichier dans votre gestionnaire de fichiers. Pour supprimer définitivement, vous n’avez
qu’à Vider la corbeille.

Dans Konqueror , vous pouvez supprimer pour de bon en une seule étape. Sélectionnez le fichier et utilisez le
menu Édition→Supprimer.

8.1.4. Surfer sur le Web

Si vous parcourez fréquemment des dossiers contenant des fichiers au format HTML, par exemple la docu-
mentation de votre distribution, ces dossiers contiennent généralement un fichier nommé index.html.

Par exemple, rendez-vous dans le dossier /usr/share/doc/mandrake/fr/. Si vous n’activez pas l’option Uti-
liser index.html, vous aurez simplement la liste des fichiers et dossiers contenus dans ce répertoire. En activant
l’option, Konqueror affichera le contenu du fichier index.html, et vous pourrez parcourir la documentation
beaucoup plus facilement, comme si vous étiez sur un site Web. Pour l’activer, accédez au menu A�chage→
Utiliser index.html.

Il est aussi facile de surfer le Web avec Konqueror qu’avec un « vrai » navigateur (voir ). Vous n’avez qu’à
entrer l’adresse du site que vous voulez visiter dans la barre de location... et surfez !

8.1.5. Partage de fichiers

Cette fonctionnalité permet de partager vos documents avec d’autres utilisateurs du réseau et accéder aux
documents que les autres utilisateurs partagent. Cela permet aussi aux administrateurs système de proposer
des dossiers communs où tout le monde peut consulter, ajouter, ou modifier des documents.

8.1.5.1. Partager des documents

Si le partage de fichier est activé dans Centre de contrôle Mandrake , cliquez avec le bouton droit sur les
répertoires de votre fenêtre Konqueror et choisissez l’onglet Partager. Cela vous permettra de partager un ou
plusieurs répertoires à travers NFS 1 ou Samba 2.

8.1.5.2. Consulter les dossiers partagés avec Konqueror

Vous pouvez consulter tous les dossiers partagés sur le réseau en ouvrant la section Navigateur dans le réseau
local de l’onglet Services de la barre latérale. Toutes les machine proposant des partages apparaîtront dans cette
section. À l’intérieur de chaque machine apparaît un dossier par protocole proposé. Ces protocoles peuvent
être :

FISH

Ce protocole repose sur les communications ssh. Ainsi, chaque machine ayant un serveur ssh vous per-
mettra de vous y connecter avec votre identifiant et naviguer dans tous les répertoires auxquels vous avez
accès.

NFS

Tous les partages proposés par les machines UNIX apparaîtront ici.

1. NFS (Network File System) permet de partager, exporter/importer des fichiers de/vers votre ordinateur dans un envi-
ronnement réseau. Même si la configuration de NFS est plus facile à effectuer que celle de Samba , elle ne peut fonctionner
que dans un environnement de systèmes UNIX (comme GNU/Linux ). De plus, le protocole NFS n’est pas sécuritaire et
devrait être utilisé exclusivement dans un environnement réseau local sécurisé.
2. Le protocole SMB permet à des PC s de partager des ressources telles que des fichiers ou des imprimantes. Les systèmes
d’exploitation Windows , GNU/Linux et OS/2 , entre autres, prennent en charge le protocole Samba . Il peut être considéré
comme une alternative à Netware et NFS . Il peut être considéré comme une alternative à Netware ou NFS .
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SMB

Enfin seront affichés ici les partages fournis par les machines Windows ou tout au moins supportant le
protocole Samba .

8.2. Browsing the Web

8.2.1. Konqueror’s Web Browser Interface

You can launch the Konqueror web browser by clicking on this icon in the panel or by selecting Use
the Internet→Browse the Web from the main menu.

Figure 8-2. Konqueror as a Web Browser

Tool-Bar. Where all buttons to navigate and perform common actions are located (see Surfing the Web, page
58).

Location Bar. Where you enter a site’s URL (or a local file using file:// as the protocol part of the URL).

Bookmarks Bar. It contains buttons which give you quick access to your bookmarked (favorite) sites.

Page Display Area. Where the contents of the web sites and local files you browse are displayed.

8.2.2. Surfing the Web

The following table summarizes the most commonly used navigation buttons Konqueror ’s web browser pro-
vides.
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Button Keyboard Shortcut Function

Button Keyboard Shortcut Function

Alt-left_arrow

Go back. Returns to the page visited before the current one. By
clicking on it more than once, you can go back more than one page,
but some pages use automatic redirection so this might not always
work. Keeping this button pressed (or clicking on the little black
triangle on its right) will show you a list of all the URLs you can
access through this feature.

Alt-right_arrow Go forward. Returns to the page visited after the current one
being visited. The same back-button considerations apply.

F5

Reload. Reloads the current page. By default, Konqueror will first
look for the page in the browser’s cache (on-disk temporary
storage space) and use the local copy. Press the Shift key while
clicking on the reload button to force Konqueror to fetch the page
from the Internet.

Esc

Stop. Stops transferring the currently requested object and will
therefore cancel the page currently being loaded. Notice that we
use the word « object » instead of « page ». This is due to the fact
that web pages are not only HTML code but images and maybe
other media too.

Tableau 8-2. Konqueror’s Web Browser Toolbar Buttons

8.2.3. Managing Bookmarks

Bookmarks store the URLs of your favorite web sites so you do not have to type their address again when you
want to access them. You can classify them by subject, category, etc. Your Mandrake Linux system already has
some bookmark categories predefined which you can use as a guide to arrange yours. Selecting Bookmarks→
Edit Bookmarks from the browser’s menu will open the bookmarks manager shown in figure 8-3.

Figure 8-3. Konqueror’s Bookmarks Manager Dialog

Bookmarks are arranged as a tree, with all operations taking place on the currently selected tree node. The
following operations are available:
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• Create Folder. Click on this button, or select Insert→Create New Folder... from the menu to create
a new folder. A dialog will pop up asking you the folder’s name: fill it and click on the OK button to create
the folder. Use folders to group bookmarks by subject, category, etc. Keyboard shortcut: Ctrl-N.

• Create Bookmark. Click on this button, or select Insert→Create New Bookmark from the menu
to create a new bookmark entry. A new entry will be added below the current node or inside the current
folder. Double click on the URL column at the bookmark’s row, type the bookmark’s URL and press the
Enter key to set the bookmark’s URL. Proceed the same way, but this time on the Bookmark column to set
the bookmark’s name.

• Delete Object. Click on this button, or select Edit→Delete from the menu to delete the currently
selected object: either a bookmark, a separator or a folder. You will not be asked for confirmation, the object
will be deleted immediately. Keyboard shortcut: Del.

• Insert Separator. Select Insert→Insert Separator from the menu to add a separating line below the current
node. Keyboard shortcut: Ctrl-I.

• Rename. Right click on a bookmark or a folder and select Rename to change the bookmark’s name. The
bookmark’s name is the text which is displayed in that bookmark’s entry. Keyboard shortcut: F2.

• Change URL. Right click on a bookmark and select Change URL to change the URL the bookmark points to.
You will be able to edit the bookmark’s URL column, make your changes and press the Enter key to change
the URL. Keyboard shortcut: F3.

Bookmarks can be exported to different browser’s format. Feel free to explore the File→Export menu. A stan-
dard file save dialog will pop up asking you for the bookmark’s file name (for example bookmarks.html for
Mozilla and netscape browsers), type the file name and click on the Save button.

Bookmarks can also be imported from different browser’s formats. Feel free to explore the File→Import menu.
A standard file open dialog will pop up asking you for the bookmark’s file name, browse the dialog for the
file, select it and click on the Open button.

Both export and import file dialogs are intelligent , in the sense
that they will start from the directory and will show the file types
that better fit the menu entry you have selected.

Once you are satisfied with your changes, click on this button or select File→Save from the menu to
store the new bookmarks. Keyboard shortcut: Ctrl-S.

8.2.4. Tabbed Browsing

Figure 8-4. Konqueror’s Browser Tabs

Konqueror ’s web browser lets you browse many web pages at a time using a very nice feature called « tabbed
browsing ». Instead of opening a new browser window every time you want to view another page, you can
instead open a new tab.

Clicking on this button in the toolbar, or choosing Window→New Tab from the menu, or pressing the
Ctrl-Shift-N keys, will create and open a new tab. You can now input the URL or select a bookmarked site to
browse that site.

Clicking on this button in the toolbar Window→Close Tab from the menu, or pressing the Ctrl-W
keys, will close the currently displayed tab. Click on a tab’s title to display the contents of that specific tab.
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Right click on a tab’s title and select Close Other Tabs to close all tabs except the currently displayed one.
Right click on a page’s link and select Open in Background Tab to open that link in a tab, but not displaying
that tab immediately. This last feature is very handy to open several linked sites at the time « to look at them
later » without leaving the site you are currently browsing.

8.2.5. Konqueror Web Browser and Plugins

Figure 8-5. Konqueror’s Browser Plugins Settings

Plugins are programs that let your browser handle content other than HTML and graphics, such as animations,
streaming audio, Java applets, and more. Konqueror uses Mozilla and netscape plugins. Select Settings→
Con�gure Konqueror... from the menu and open the Plugins section to set Konqueror ’s web browser plugins’
preferences (see figure 8-5).

After you have (optionally) downloaded and installed the corresponding plugins, click on the Scan for New
Plugins button to have Konqueror recognize and setup the installed plugins: all directories listed in the Scan
Directories list will be searched for.

You can check which plugins are set up in the Plugins tab. By default, only the Netscape Plugin (which gives
Konqueror access to Mozilla ’s and netscape ’s plugins) is installed. Once you are satisfied with the settings,
click on the OK button to make them effective.
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Chapitre 9. Courrier électronique : KMail

Il existe de nombreux logiciels de courrier électronique fonctionnant en mode graphique sous GNU/Linux :
KMail , Evolution , Mozilla Messenger , etc. Ce chapitre traitera de la configuration et de l’utilisation de KMail
pour composer, lire et organiser vos messages.

9.1. Configuration de KMail

Vous pouvez lancer KMail en cliquant sur cette icône ou en sélectionnant Réseau+Courrier→KMail
depuis le menu principal. Notez que nous n’expliquerons que étapes minimales nécessaires au bon fonction-
nement du logiciel. Sentez-vous à l’aise d’explorer les autre options de configuration par vous-même.

En cliquant surCon�guration→Con�guration KMail, vous afficherez la fenêtre de configuration. Elle est consti-
tuée d’une liste de catégories (sur la gauche) et d’options de configuration pour chacune de ces catégories (sur
la droite). Premièrement, une identité1 doit être définie dans la catégorie Identités. KMail vous offre un « sque-
lette » contenant une identité par défaut créée à partir des données de votre compte (login, nom, etc.). Cliquez
sur le bouton Modi�er et dans l’onglet Général remplissez les champs Votre nom, Organisation et Adresse
électronique (voir figure 9-1).

Figure 9-1. Régler les paramètres généraux d’un utilisateur

Utilisez les onglets Options avancées et Signature pour régler d’autre paramètres tels qu’une adresse différente
d’Adresse de réponse, une clé GPG pour sécuriser la transmission de vos messages ainsi de suite. Une fois que
vos réglages vous satisferont, cliquez sur OK puis sur Appliquer : vous venez tout juste de créer votre identité
par défaut.

Pour configurer les serveurs de courrier électronique, sélectionnez la catégorie Réseau. Dans l’onglet Envoi
des messages, cliquez sur le bouton Ajouter..., choisissez le transport SMTP et cliquez sur OK. Dans l’onglet
Général, remplissez le champ Nom et le champ Serveur avec le nom du serveur SMTP ou son adresse IP (voir
figure 9-2). Les autres champs peuvent demeurer tel quel, abritant leur valeur par défaut.

1. Si vous possédez plus d’une adresse de courriel, par exemple une pour le travail et une autre pour votre correspon-
dance personnelle, il est utile de créer une identité pour chacun d’entre eux.
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Figure 9-2. Configuration du serveur de sortie du courrier électronique

Pour recevoir votre courrier, vous devez créer au moins un compte. Dans l’onglet Réception des messages,
cliquez sur le bouton Ajouter..., choisissez POP3 comme type de compte2 et cliquez sur OK. Dans l’onglet
Général, donnez un nom Nom approprié au compte puis remplissez le champ Serveur avec le nom du serveur
POP3 ou son adresse IP. Votre FAI devrait vous avoir donné un nom d’utilisateur et un mot de passe qui
doivent être entrés dans les champs respectifs. Cochez l’entrée Enregistrer le mot de passe POP dans le �chier
de con�guration pour éviter d’avoir à entrer votre mot de passe à chaque fois que vous voulez récupérer vos
messages (voir figure 9-3). Cliquez sur OK pour ajouter le compte.

Toutefois, le fait d’enregistrer votre mot de passe dans le fichier
de configuration peut affaiblir la sécurité de votre système. Si vous
choisissez cette option, quiconque accédant à votre ordinateur alors
que vous êtes connecté (logged in) pourra lire (ou pis encore, effa-
cer) votre courrier : utilisez cette option à vos propres risques.

2. Vu que la plupart des FAI procure des comptes POP3 pour récupérer votre courrier, nous l’avons utilisé dans notre
exemple. Si vous avez un autre type de compte, comme IMAP (Internet Mail Access Protocol), la configuration est un peu
différente.
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Figure 9-3. Configuration d’un compte POP3

Si vous possédez une connexion permanente à Internet (comme
DSL ou modem-câble), le fait de cocher l’option Activer la vé-
ri�cation régulière du courrier et de sélectionner une intervalle
de vérification (en minutes) (Activer la véri�cation régulière du
courrier) indiquera à KMail de récupérer vos messages périodique-
ment.

Si vous voulez que KMail gère plus d’un compte de courrier, vous n’avez qu’à répéter la procédure susmen-
tionnée pour chacun des comptes supplémentaires. Une fois que vos réglages vous satisfont, cliquez sur OK.
KMail est maintenant prêt à envoyer et à recevoir du courrier depuis Internet.
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9.2. L’interface de KMail

Figure 9-4. Interface du client de courrier

Barre d’outils. Où les boutons associés aux actions principales résident. Voir tableau 9-1.

Liste de messages. Où l’information (sujet, date, expéditeur, etc.) au sujet des messages stockés dans le réper-
toire couramment sélectionné est affichée.

Panneau des messages. Là où le contenu du message sélectionné s’affiche.

Liste des dossiers. Où tous vos dossiers résident. Les dossiers par défaut sont Boı̂te de réception (messages
entrants), Brouillons, À envoyer (messages non envoyés), Envoyés (messages déjà envoyés) et Corbeille
(messages effacés).

Le tableau suivant montre et décrit les boutons les plus importants qui sont disponibles dans la barre d’outils
de KMail . Il liste également leur raccourci-clavier respectif et explique leur fonction.

Boutton Raccourci-
clavier

Fonction

Ctrl-N Composer un nouveau message. Vous devrez remplir les champs À et
Sujet dans la fenêtre de composition de message.

Ctrl-L

Récupérer les messages pour tous les comptes de courrier définis.
Gardez ce bouton enfoncé et une liste de tous vos comptes sera
affichée. Sélectionnez celui pour lequel vous désirez uniquement
récupérer les messages.

R Répondre à l’auteur du message sélectionné. Une fenêtre de
composition s’affichera. Quelques champs seront déjà remplis.

A
Répondre à l’auteur et à tous les destinataires originaux du message
sélectionné. Une fenêtre de composition s’affichera. Quelques champs
seront déjà remplis.
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Boutton Raccourci-
clavier

Fonction

F
Transférer (envoyer à un tiers parti) le message sélectionné. Vous
devrez remplir le champ À dans la fenêtre de composition de message.

D

Effacer les messages sélectionnés. Les messages effacés sont déplacés
dans le dossier Corbeille. Vous pouvez récupérer ces messages, mais
il est impossible de récupérer les messages qui auront été effacés
depuis la Corbeille : faites attention !

Tableau 9-1. Boutons de la barre d’outils de KMail

9.3. Composer un message

Figure 9-5. La fenêtre de composition des messages

Barre d’outils. Là où résident les boutons principaux de composition. Voir tableau 9-2.

Corps du message. La partie de la fenêtre qui contient le contenu de votre message.

Destinataires du message. La liste de tous les destinataires à qui un message s’adresse. Par défaut, les options
suivantes sont affichées :

• À : le destinataire « principal » à qui s’adresse ce message.

• Cc (copie conforme) : destinataire « secondaire » visible à qui s’adresse ce message. Tous les destinataires
sauront à qui ce message a été envoyé.

Choisissez A�chage→BCC depuis le menu pour afficher le champ
BCC (Blind Carbon Copy , soit copie conforme cachée). Ces desti-
nataires sont également secondaires mais sont cachés aux autre
destinataires de ce message. Aucun destinataire n’aura accès aux
adresses des destinataires mis en BCC.

Identité d’envoi. L’identité sous laquelle vous envoyé un message. Si vous avez plus défini plus d’une identité,
choisissez celle de votre choix dans la liste déroulante.

Le tableau suivant montre les boutons qui sont le plus utilisés dans la fenêtre de composition de message.
Nous vous indiquons également leur raccourci-clavier ainsi que leur fonction.
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Bouton Raccourci-
clavier

Fonction

Ctrl-Entrée
Envoie le message immédiatement (votre connexion réseau doit être
active). Une copie de votre message sera conservée dans le dossier
Envoyés.

Mettre le message en attente. Le message sera sauvegardé dans le
dossier À envoyer et sera envoyé la prochaine fois que vous
demanderez que le courrier soit envoyé.

Attacher un fichier au message. Cette fonction est aussi accessible à
travers le menu Joindre→
Joindre un �chier.... Une fenêtre contextuelle standard apparaîtra.
Choisissez le fichier que vous voulez attacher et cliquez sur OK.
Répétez l’opération si vous voulez envoyé plusieurs fichiers.

Tableau 9-2. Boutons de la barre d’outils de composition de message

9.4. Dossiers et filtres

Vous pouvez trier votre courrier automatiquement dans des dossiers selon des critères précis (l’expéditeur,
le sujet, la date, etc.) en utilisant des filtres. Les filtres sont très puissants mais dans nos exemples nous
n’utiliserons que des règles de filtrage simples. Sentez-vous à l’aise d’explorer les outils de filtrage (accédez
au menu Outils→Créer un �ltre...).

Assumons que vous vouliez filtrer les messages entrants en fonction de l’expéditeur et que vous ayez au moins
un message de cet expéditeur dans votre dossier Boı̂te de réception. Vous voulez que tous les courriers
provenant de un_utilisateur@une_entreprise.net soient placés dans le dossier Un_Utilisateur. Premiè-
rement, vous devez créer un nouveau dossier pour stocker les messages.

Pour créer un nouveau dossier, choisissez Dossier→Nouveau dossier... depuis le menu principal. Dans le
champ Nom, entrez le nom du nouveau dossier (Un_Utilisateur dans notre exemple). La liste déroulante
Appartient à spécifie son dossier parent. Si vous le réglez à Racine des dossiers (par défaut), ce dossier n’aura
pas de parent. Les valeurs par défaut peuvent être conservées pour les autres options. Cliquez sur OK pour
créer le dossier.

Pour créer le filtre, sélectionnez un des messages de l’expéditeur et faites un clic droit dessus. Depuis le menu
contextuel, choisissez Créer un �ltre→Filtrer sur l'expéditeur... et la règle de filtrage sera automatiquement
créée. Toutefois, vous devrez choisir le dossier de destination (Actions du �ltre) et accepter cette règle en
cliquant sur OK. Vous pouvez créer autant de règle de filtrage que vous le désirez.
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10.1. Traitement de texte

Cette section vous donnera un bref aperçu des fonctionnalités du traitement de texte OpenOffice.org Writer .
Plusieurs options existent pour les traitements de texte dits WYSIWYG (What You See Is What You Get, soit « Ce
que vous voyez est ce que vous obtenez »). Vous pourriez utiliser KWord , StarOffice Writer, AbiWord , etc.
Nous miserons toutefois sur OpenOffice.org Writer .

Afin de rendre la lecture de ce chapitre plus facile, nous alternerons
entre l’acronyme populaire OOo, et le nom très long quoique correct
qu’est OpenOffice.org .

10.1.1. Qu’est-ce qu’un traitement de texte ?

Une des tâches les plus courantes sur un ordinateur est d’utiliser un traitement de texte. C’est le remplacement
moderne de la machine à écrire. Ce type de logiciel vous permet d’écrire en utilisant plusieurs types de police,
des alignements de paragraphe, des tableaux, des images, des listes, etc.

Les traitements de texte proposent aussi des fonctions de publication. Toutefois, elles sont assez limitées :
la précision des mesures est relative, le positionnement d’images autour d’un texte donné ou d’un tableau
s’avère difficile, etc.

10.1.2. OpenOffice.org Writer

OpenOffice.org Writer constitue la partie traitement de texte de la suite OpenOffice.org . OpenOffice.org
Writer prend en charge les formats populaires, ce qui facilite la transition et assure la compatibilité entre les
suites bureautiques.

10.1.2.1. Ouvrir OpenOffice.org Writer

Pour démarrer OpenOffice.org Writer , choisissez Bureautique→Traitements de texte→OpenO�ce.org Wri-
ter depuis le menu principal.

Vous pouvez également l’ouvrir depuis n’importe quelle application de la famille OOo, en sélectionnant
Fichier→Nouveau→Document texte, ce qui ouvrira une fenêtre OpenOffice.org Writer contenant un do-
cument vide.

La première fois que vous démarrez OOo, un dialogue propose
d’enregistrer votre logiciel. En remplissant un court questionnaire,
vous aiderez les développeurs de OpenOffice.org à mieux con-
nâıtre leurs utilisateurs et obtenir des remarques pour améliorer
OpenOffice.org . Vous êtes encouragé à répondre au questionnai-
re si vous avez une connexion Internet, mais vous pouvez ignorer
cette étape sans aucune conséquence pour votre utilisation de Ope-
nOffice.org .
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10.1.2.2. L’interface de OpenOffice.org Writer

Figure 10-1. La fenêtre principale de OpenOffice.org Writer

Barre de mise en forme

Voici la barre de mise en forme standard pour toutes les applications OpenOffice.org . Elle est utilisée
pour changer les types de police, les couleurs, l’alignement, etc.

Règle

Elle définit la location « horizontale » du texte et des éléments de mise en page. Elle est très utile lorsque
vous voulez régler des tabulations ou des indentations de paragraphe.

Aire de travail

Espace où vous entrez le contenu de votre document : mots, nombres, images, tableaux, hyperliens, etc.

Point d’insertion

Tous les caractères que vous taperez seront placés à gauche de ce point. Le point d’insertion est également
appelé « curseur ».

Styliste

Cliquez sur n’importe quel style affiché dans cette liste pour changer le style actuel associé au texte sélec-
tionné. Si aucun texte n’est sélectionné, le style s’appliquera au document en entier.

Style de page

La taille de la page, les marges, l’orientation du texte, etc., définissent le style d’un document. Le style
de page peut être modifié par l’entremise du menu Format→Page. Vous pouvez utiliser un des styles
prédéfinis ou en personnaliser un vous-même.

Zoom

Affiche le niveau de zoo associé à l’affichage de page, 100% par défaut. Vous pouvez le réduire à 50%,
par exemple, pour obtenir un aperçu de la mise en page de votre document. Toutefois, la fonctionnalité
d’aperçu de page (plus d’information là-dessus un peu plus loin) constitue une meilleure façon de faire.

Mode d’insertion

Lorsque le terme RFP apparaît, les caractères que vous taperez écraseront ceux déjà existants au point
d’insertion. Lorsque INS apparaît (le mode par défaut), le texte déjà existant au point d’insertion ne sera
pas écrasé par les caractères que vous entrerez, ils seront « insérés ».
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10.1.3. Utilisation du traitement de texte

10.1.3.1. Styles

De manière générale, les utilisateurs de traitement de texte perdent beaucoup de temps à formater leur do-
cument (changer l’alignement des paragraphes, le type de police, la taille du document, etc.) au lieu de se
concentrer sur leur structure et leur contenu.

L’utilisation de styles permet une certaine approche mettant l’emphase sur la structure, tout en « normalisant »
le formatage et la mise en page d’un document, et en facilitant la génération et l’entretien d’une table des
matières (TDM). Sous OpenOffice.org Writer , les styles sont gérés par l’entremise du Styliste .

Cliquez sur cette icône de la barre d’outils pour accéder au Styliste . Vous pouvez également l’ouvrir
en choisissant Format→Styliste depuis la barre de menu, ou en appuyant sur la touche F11.

Si le Styliste est déjà activé, toutes les actions susmentionnées
auront pour effet de le fermer.

Lorsque vous voulez utiliser... Appliquez le Style...

Titre de chapitre Titre 1

Titre de section Titre 2

Titre de sous-section Titre 3

Titre de sous-sous-section Titre 4

Paragraphe Standard, Corps de texte, Alinéa

Item de liste Standard, Corps de texte, Alinéa

Tableau 10-1. Styles suggérés

Utilisez les styles décrits dans tableau 10-1 en tant que guide. Choisissez la région de votre document auquel
vous voulez appliquer un style précis et, dans la fenêtre du Styliste , double-cliquez sur le style de votre
choix.

Les styles que vous utilisez depuis le Styliste deviennent dispo-
nibles dans la liste contextuelle (soit la première dans le la barre de
mise en forme). Ainsi, les styles que vous utilisez le plus fréquem-
ment deviennent aisément disponibles.

10.1.3.2. Marges

Vous pouvez toujours les ajuster manuellement avec la règle, mais si vous voulez formater un texte long, ce
n’est pas la meilleure solution. C’est là que le Styliste entre en jeu.

En cliquant sur cette icône dans le Styliste , vous accéderez à la section de formatage de page du
Styliste . Premièrement, faites une copie du style Standard :

1. Faites un clic droit sur l’item Standard du styliste.

2. Choisissez Nouveau... depuis le menu qui apparaîtra.

3. Assignez un Nom à votre nouveau style. Dans notre exemple, nous utiliserons le nom de style Copie
défaut.

4. Cliquez sur OK pour insérer votre nouveau style dans la liste de styles disponibles.

Ensuite, faites un clic droit sur le style que vous venez de créer et choisissez Modi�er... depuis le menu contex-
tuel. La fenêtre Style de page: Copie défaut apparaîtra. Ouvrez l’onglet Page et modifiez les marges comme
bon vous semblera.
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Cette opération peut également se faire par l’entremise du menu
Format→Page.

En jetant un œil sur la fenêtre Styles de page : Copie par défaut, vous aurez probablement remarqué que vous
pouvez modifier plusieurs éléments tels que l’Arrière-plan, l’En-tête, le Pied de page, etc. Par exemple, si 90 %
de votre travail avec un traitement de texte se résume à l’écriture de lettre d’affaires, vous pourriez régler ces
éléments tout de suite, vous faisant épargner beaucoup de temps.

Notez qu’une fois que vous aurez modifié les réglages de formatage
par défaut, vous enregistrerez par-dessus ceux réglés originellement.
Si vous croyez avoir fait une erreur en changeant les réglages par
défaut, cliquez simplement sur le bouton Réinitialisation pour re-
venir aux réglages originels.

10.1.3.3. Listes

Il arrive que certains paragraphes abritent des listes d’éléments qui servent à énumérer les propriétés d’un
objet (liste « ordonnée » ou « à puce »), ou à décrire les étapes nécessaires pour accomplir une tâche donnée
(liste « ordonnée » ou « numérotée »).

En cliquant sur ce bouton, vous transformerez le texte sélectionné en liste non ordonnée. En choisis-
sant les items de la liste en accédant au menu Format→Numérotation/puces..., vous pourrez changer
le type de puce depuis un ensemble prédéterminé. Sentez-vous à l’aise d’explorer les autres options.

En cliquant sur ce bouton, vous transformerez le texte sélectionné en liste ordonnée. Les mêmes règles
que pour les listes non ordonnées s’appliquent en ce qui a trait au format de numérotation.

10.1.3.4. Mise en page en plus d’une colonne

En choisissant Format→Colonnes, vous ouvrirez un menu contextuel tel qu’illustré dans figure 10-2, ce qui
vous permettra de disposer votre texte en plusieurs colonnes.

Figure 10-2. Menu d’options pour les colonnes de texte

Ces options parlent d’elles-mêmes. Faites votre sélection et cliquez sur OK pour appliquer vos modifications.

10.1.3.5. Table des matières

Afin de donner un look professionnel à votre document, vous pouvez créer une table des matières (ou TDM)
ainsi qu’un index. OpenOffice.org vous permet de faire cela facilement.
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Figure 10-3. Table des matières

L’image dans figure 10-3 montre comment la TDM pour un document type sera affichée.

Même si les éléments de la TDM peuvent être insérés manuelle-
ment, il est fortement recommandé d’utiliser les styles afin que la
TDM soit constante et facile à entretenir.

Admettons que vous vouliez insérer une TDM au début de votre document et que vous ayez utiliser les styles
suggérés dans tableau 10-1. Faites un saut de page au tout début de votre document en appuyant sur les
touches Ctrl-Enter.

Puis, en choisissant Insertion+Index→Index depuis la barre de mise en forme, le menu d’options de table des
matières et d’index apparaîtra. Assurez-vous que le champ Type est réglé à Table des matières et que la boîte
Protégé contre toute modi�cation manuelle est cochée. Remplissez les champs de titre ainsi que les autres
options et lorsque vous serez satisfait des options choisies, cliquez sur OK pour insérer la TDM.

Si vous continuez à ajouter du contenu à votre document (soit « structurel » ou « essentiel »), vous devrez
actualiser la table des matières, afin que vos ajouts et modifications soient pris en compte. Pour ce faire, cliquez
sur n’importe quelle partie de la TDM, puis faites un clic droit et choisissez Actualiser l'index depuis le menu
qui apparaîtra.

10.1.3.6. Index

Pour indexer les termes importants de votre document, procédez de façon similaire à celle utilisée dans
l’exemple de la table des matières :

1. Choisissez le mot que vous désirez indexer.

2. Accédez au sous-menu Insertion→Index→Entrée...

3. Dans le champ Index, choisissez Index lexical.

4. Lorsque vous aurez terminé d’entrer tous les termes que vous désirez indexer, générez la table d’index en
accédant au sous-menu Insertion→Index→Index

Souvenez-vous de choisir un Titre et un Type à l’Index lexical.
Aussi, souvenez-vous qu’un index se place à la fin d’un document.
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10.1.3.7. En-têtes et pieds de page

Par défaut, ils sont communs à toutes les pages d’un document. Utilisez-les pour décrire certains aspects du
contenu d’un document, par exemple, le numéro de page, le nombre total de page, le titre d’un chapitre ou
d’une section, le titre d’un document, etc.

Après avoir inséré un en-tête (Insertion→En-tête→Standard) ou un pied de page (Insertion→Pied de page→
Standard), tapez le texte pertinent pour l’un et l’autre de ces composants. Vous pouvez aussi utilisez le menu
Insertion→Champ pour composer des en-têtes et des pieds de page.

10.1.4. Pour aller plus loin

Si vous souhaitez en apprendre plus sur le fonctionnement de OpenOffice.org Writer , vous pouvez consul-
ter ce Tutoriel (http://fynl.free.fr/OOWriter/TutorialWriter.html).

N’hésitez pas non plus à vous reporter à l’aide en ligne de OpenOffice.org Writer accessible grâce au menu
Aide→Sommaire. Vous y trouverez la réponse à toutes vos questions. Les sujets sont accessibles par la table
des matières, mais aussi par l’index et il y a un outil de recherche contextuel.

OpenOffice.org Writer est capable d’exporter vos documents au
format PDF (Fichier→Exporter au format PDF ...). Cela permet
de communiquer vos documents dans le célèbre format Adobe®
Reader®.

10.1.5. Conclusion

L’interaction avec un traitement de texte peut être considérée comme une des tâches les plus effectuées avec un
ordinateur personnel. Comme vous avez pu le lire, OpenOffice.org Writer ne vous fournit pas seulement
les outils pour créer des documents simples ou complexes : il est également compatible avec les autres formats
de fichiers bureautique. Nous espérons que vous apprécierez OpenOffice.org Writer !

10.2. Tableurs

Cette section constitue une rapide introduction aux fonctionnalités du tableur OpenOffice.org Calc . Une
autre très bonne alternative est gnumeric , le tableur du projet GNU.

Nous supposons que vous savez pourquoi vous voulez utiliser un tableur, et ne rentrerons pas dans le détail
des multiples applications possibles (comptabilité, finances, simulations, statistiques, etc.).

10.2.1. Qu’est-ce qu’un tableur ?

Les tableurs ou feuilles de calcul (spreadsheet) sont le pendant électronique du grand livre d’un comptable. Ces
logiciels utilisent colonnes et lignes pour permettre l’application de calculs mathématiques sur des données
déjà insérées. De nos jours, il est possible de faire une panoplie d’opérations impressionnantes avec un tableur,
comme une base de données très simple ou un générateur de diagrammes et graphiques, même si ce n’est pas
là leur domaine de prédilection.
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Figure 10-4. Lignes, colonnes et cellules

Les lignes sont nommées numériquement 1, 2, etc. Les colonnes sont quant à elles nommée alphabétiquement
A, ..., Z, AA, AB, etc. L’intersection d’une ligne et une colonne s’appelle une cellule, elle est désignée par son nom
de colonne et de ligne, par exemple: C3 (dans l’illustration figure 10-4).

Les tableurs, aussi étonnant que cela puisse sembler aujourd’hui, ont joué un rôle crucial dans le dévelop-
pement des ordinateurs personnels et de bureau. Ils constituaient pour beaucoup de sociétés l’application
incontournable justifiant l’achat d’un ordinateur.

10.2.2. OpenOffice.org Calc

OpenOffice.org (anciennement StarOffice ) est une suite office populaire depuis quelques années déjà sous
GNU/Linux . Avec la création de OpenOffice.org , les auteurs ont remodelé les fondations de StarOffice en
utilisant des composants libres ; ils ont également introduit le format de fichier natif XML. Le potentiel de
cette suite office est maintenant irréfutable. OpenOffice.org Calc se veut la partie tableur de cette suite.

10.2.2.1. Ouvrir OpenOffice.Org Calc

Pour démarrer OpenOffice.org , accédez au menu Bureautique→Tableur→OpenO�ce.Org Calc depuis le me-
nu principal.

À partir de n’importe quelle application de OpenOffice.org , vous pouvez aussi accédez au sous-menu
Fichier→Nouveau→Tableur pour ouvrir une feuille de calcul vierge.

10.2.2.2. L’interface de OpenOffice.org Calc

Figure 10-5. La fenêtre principale de OpenOffice.org Calc

Barre de style

Il s’agit de la barre de style commune à toutes les applications OpenOffice.org pour modifier la police,
couleur, alignement, etc. des données de l’application.
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Barre de formule

Utiliser cette barre pour écrire ou modifier une formule dans une cellule.

Zone de travail

la feuille de calcul proprement dite sur laquelle entrer et afficher les données : nombres, dates, formules,
images, etc.

Sélectionner tout

En cliquant sur ce bouton situé dans le coin supérieur droit de la zone de travail, vous sélectionnerez tou-
tes les cellules d’un seul coup. C’est utile si vous désirez appliquer des changements (de style notamment)
« globaux » sur toute la feuille. Par exemple, en changeant la taille des polices à 10 points (pts).

Boutons de changement de feuille

Un document de feuille de calcul peut comporter plusieurs feuilles. Utilisez ces boutons pour naviguer
facilement d’une feuille à l’autre. De gauche à droite nous avons : Aller à la première feuille, Aller à la
feuille précédente, Aller à la feuille suivante et Aller à la dernière feuille.

Feuilles

Vous pouvez utilisez les onglets des feuilles pour aller directement à une feuille en particulier.

10.2.3. Utiliser la feuille de style

OpenOffice.org Calc est une application prête pour les milieux professionnels les plus exigeants. Cette ap-
plication inclut de nombreuses fonctions nettement au-delà des objectifs de cette section. Consultez Pour aller
plus loin, page 79 pour voir comment apprendre à vous servir à fond de OpenOffice.org Calc .

Les sections qui suivent vont aborder les fonctions de base pour insérer des données et des formules, puis
créer des diagrammes pour représenter ces données. Un exemple imaginaire d’un livre de comptes mensuel
succinct d’une société sera utilisé.

10.2.3.1. Entrer les données

Pour entrer des données dans une cellule (texte ou chiffres), utilisez les touches fléchées pour vous déplacer
sur la cellule voulue ou cliquez sur cette cellule. Tapez ensuite vos données au clavier, et pressez la touche
Entrée lorsque vous avez terminé. Vous pouvez aussi utiliser les touches de Tabulation ou Shift-Tab pour
vous déplacer respectivement sur la cellule de droite ou du bas.

La fonctionnalité d’auto-complètement (auto-completion) facilite l’entrée de données. Le programme va essayer
de « deviner » les données à insérer dans la cellule suivante en fonction de la cellule courante. Cela fonctionne
non seulement pour les données numérique mais aussi pour les jours de la semaine, les mois de l’année, etc..
De manière générale, tout type de données pouvant se ramener à une série d’entiers consécutifs pourra être
reconnu.

Figure 10-6. Simplifier l’entrée de données en utilisant l’auto-complètement
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Pour utiliser l’auto-complètement, sélectionnez la cellule de base, puis cliquez sur la « poignée » de la cellule
(située sur le coin bas doit du bord). Faites alors glisser votre souris en maintenant le bouton appuyé. La valeur
des nouvelles cellules sera affichée dans une bulle (voir figure 10-6). Une fois que vous avez atteint la dernière
cellule à remplir, relâchez le bouton de la souris et les cellules seront remplies.

Les cellules peuvent aussi être triées en fonction de divers critères (en colonnes ou lignes selon l’organisation
de vos données). Pour ce faire, commencez par sélectionner la zone de cellules que vous souhaitez trier, puis
ouvrez la boite de dialogue de tri en choisissant le menu Données→Trier.

Assurez vous de sélectionner aussi les cellules qui servent d’en-tête
aux données (dans notre exemple la colonne B qui contient le nom
des mois) de façon à ce que celles-ci suivent aussi le tri des données.

Dans l’onglet Critères de tri sélectionnez les lignes ou colonnes devant servir de critère de tri, puis l’ordre de
tri Croissant ou Décroissant. L’onglet Options propose des paramètres de tri personnalisés, de faire un tri selon
la casse (majuscule/minuscule) ou non et la direction du tri (de haut en bas pour les données disposées en
colonnes et de droite à gauche pour les données disposées en lignes), etc. Cliquez sur le bouton OK lorsque
vos critères de tri sont choisis, et le tri sera effectué.

10.2.3.2. Ajouter des formules

Les formules sont utilisées pour « automatiser » la feuille de style, vous permettant par exemple de lancer des
simulations. Dans les cellules, les formules sont définies en rentrant le signe =. Tout le reste est traité comme
des données « statiques ».

Les opérations sont décrites en utilisant la notation algébrique conventionnelle. Par exemple =3*A25+4*(A20+C34/B34)
divise la valeur de la cellule C34 par celle de la cellule B34, ajoute la valeur de la cellule A20 au résultat, mul-
tiplie ce dernier par 4 puis ajoute 3 fois la valeur de la cellule A25. Ainsi, des expressions assez complexes
peuvent être simplifiées en utilisant des expressions plus simples à la base.

OpenOffice.org Calc propose un grand nombre de fonctions prédéfinies utilisables dans les formules. Il
existe des fonctions en rapport avec la date et l’heure, les mathématiques, les statistiques, la finance, la logique,
etc. Explorez toutes ces fonctions avec l’AutoPilote de fonctions depuis le menu Insertion→Fonction.

Sous KDE , la combinaison de touches Ctrl-F2 vous permet d’aller
au bureau virtuel numéro 2. Vous voudrez peut-être redéfinir ce
raccourci clavier afin de pouvoir utiliser l’autoPilote de OpenOffi-

ce.org Calc .

figure 10-7 montre la fonction AVERAGE appliquée à la zone de cellules sélectionnée pour calculer leur valeur
moyenne. Notez l’utilisation du signe : pour désigner une plage contiguë de cellules dans la fonction.

Figure 10-7. Utilisation d’une formule
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10.2.3.3. Diagrammes : présentation graphique des données

Lorsqu’une feuille de calcul contient beaucoup d’informations, il devient difficile de cerner les relations entre
les différents types de données : trop de chiffres et pas assez de sens. La meilleure façon de résoudre ce pro-
blème se trouve dans l’utilisation des graphiques.

Comme pour toutes les fonctions d’analyse de données, il faut préalablement sélectionner les données que
vous souhaitez afficher dans le diagramme. Sélectionnez donc une zone de cellules puis choisissez le menu
Insertion→Diagramme... pour afficher l’assistant pour les diagrammes.

Figure 10-8. Choix du type de diagramme

Après avoir confirmé la sélection dans la première page de l’assistant en cliquant sur le bouton Suivant >>,
vous verrez la page de sélection du type de diagramme (dans figure 10-8, un diagramme en barre 3D est
choisi). Faites votre choix et passez à l’étape suivante (Suivant >>) pour afficher des variantes du choix initial.
Faites vos choix et vous pourrez à l’étape suivante choisir les options finales du diagramme comme son titre,
le titre des axes, etc. Cliquez sur Créer lorsque vous avez fini pour insérez le diagramme sur la feuille (voir
figure 10-9).

Figure 10-9. Un diagramme 3D dans une feuille de calcul

Les diagrammes sont actifs dans la feuille de style, et s’adaptent
automatiquement lorsque vous modifiez les valeurs des cellules af-
fichées dans le diagramme.
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Un clic droit sur un diagramme fait apparâıtre un menu avec des
options permettant de changer les paramètres de ce diagramme.
Certains objets comme le titre du diagramme peuvent être modifiés
simplement en faisant un double-clic dessus.

10.2.4. Pour aller plus loin

Si vous souhaitez en apprendre plus sur le fonctionnement de OpenOffice.org Calc , vous devriez consulter
le tutoriel disponible sur le site OpenOffice Support (http://www.openofficesupport.com/calctutorial.
html).

N’hésitez pas non plus à vous reporter à l’aide en ligne de OpenOffice.org Calc accessible grâce au menu
Aide→Sommaire. Vous y trouverez la réponse à toutes vos questions. Les sujets sont accessibles par la table
des matières, mais aussi par l’index et il y a un outil de recherche contextuel.

10.2.5. Conclusion

Les feuilles de calcul simplifient immensément la tâche du comptable ou toute autre tâche faisant intervenir
des chiffres. Elles sont utilisées partout dans le monde, du propriétaire du magasin du coin de la rue qui gère
ses horaires, aux plus grandes firmes de comptabilité, qui les utilisent pour produire leurs rapports.

OpenOffice.org Calc offre des fonctionnalités avancées pour les utilisateurs expérimentés. Vous pouvez
l’utiliser comme simple base de données ou y programmer un interface complète d’application numérique.
Vous pouvez aussi convertir les formats, définir des modèles, etc. OpenOffice.org Calc est une application
puissante et souple et restera incontournable encore de longues années.

10.3. Logiciel de présentation

Cette section vous donnera un aperçu rapide des fonctionnalités du logiciel de présentation OpenOffice.org

Impress . Bien que distribué gratuitement, il rivalise avec tous les coûteux logiciels commerciaux. Il permet
de concevoir des présentations multimédias pour tous les besoins, et ces fonctionnalités en font un bon choix
pour n’importe quel champ d’activité.

10.3.1. Qu’est-ce qu’un logiciel de présentation ?

Que vous soyez un représentant, un ingénieur, un comptable ou un étudiant, vous devez « communiquer » à
propos de votre produit, votre analyse ou, simplement, votre travail, et ce de façon succincte et simple.

Au lieu d’utiliser des pages et des pages de texte agrémenté de quelques graphique, voire aucun, il est préfé-
rable d’utiliser des images, des graphiques, de petits tableaux, bien choisir vos mots et, peut-être, utiliser des
animations afin de bien transmettre vos idées : vous serez aussi en mesure de projeter votre présentation sur
un écran géant, ou un mur. Voici ce que vous permet de faire un logiciel de présentation.

10.3.2. OpenOffice.org Impress

OpenOffice.org Impress constitue la partie de la suite bureautique OpenOffice.org qui procure les fonc-
tionnalités de logiciel de présentation. Comme tous les composants de OpenOffice.org , il prend en charge
les autres formats populaires de bureautique.
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10.3.2.1. Ouvrir OpenOffice.org Impress

Pour lancer OpenOffice.org , accédez au menu Bureautique→Présentations→OpenO�ce.org Impress du me-
nu principal.

À partir de n’importe quelle application de la suite OpenOffice.org , accédez au sous-menu Fichier→
Nouveau→Présentations, ce qui aura pour effet d’ouvrir une fenêtre Impress affichant l’AutoPilote de Pré-

sentation (à moins que vous n’ayez déjà ouvert OpenOffice.org Impress et que vous ayez désactivé cet
assistant).

Lorsque vous lancerez OpenOffice.org Impress , l’AutoPilote de Présentation s’ouvrira. Il offre trois
choix explicites : Présentation vierge, À partir d'un modèle et Ouvrir une présentation existante. Dans notre
exemple, nous utiliserons une Présentation vierge, nous cliquerons sur Suivant pour les écrans 2 et 3, et nous
utiliserons les valeurs standards. Puis, cliquez sur le bouton Créer.

La fenêtre de type de diapositive apparaîtra (figure 10-10) et il vous sera demandé de choisir un modèle type
de diapositive. Bien sûr, le fait de choisir un modèle particulier ne lie pas toutes vos diapositives à ce modèle :
ce n’est que le modèle de départ. Choisissez celui que vous voulez utiliser pour la plupart de vos diapositives.
Dans notre exemple, nous avons choisi Titre, texte.

Figure 10-10. Choisir un modèle de diapositive

Essayez de ne pas surcharger vos diapositives avec trop de conte-
nu car, même si l’effet peut sembler joli à l’écran, cela risque de
confondre votre public lorsque vous exécuterez votre présentation.
Nous vous suggérons d’utiliser le modèle le plus simple possible.
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10.3.2.2. L’interface de OpenOffice.org Impress

Figure 10-11. Fenêtre principale de OpenOffice.org Impress

Barre de mise en forme

Elle comprend des options qui permettent de définir les ombres des diapositives, la couleur d’arrière-
plan, l’épaisseur des lignes, etc.

Mode de visualisation

Ces boutons vous permettent d’alterner entre :

• Mode Dessin. Le mode standard utilisé pour composer les diapositives.

• Mode Plan. Affiche une liste numérotée de toutes les diapositives sur la gauche, le texte qu’elles abritent
(ce qui permet de l’éditer, par exemple), ainsi qu’une fenêtre de prévisualisation sur la droite, vous
donnant une idée du résultat final.

• Mode Diapo. Affiche toutes les diapositives à la fois, ce qui permet de les parcourir et d’avoir un aperçu
de l’entièreté de votre présentation.

• Mode Note. Vous pouvez ajouter des notes à votre présentation afin d’aider vos collègues, votre public
(si vous imprimez les notes) ou vous-même lors de la présentation.

• Mode Prospectus. Ce mode peut être utile si vous voulez imprimer plusieurs diapositives sur une page
et distribuer des copies à votre public. C’est presque obligatoire pour les présentations professionnelles.

• Lancer la présentation à l'écran. En appuyant sur ce bouton, votre présentation sera « exécutée » en
plein écran. Ce même bouton se trouve également à la fin de la barre d’outils (voir explications plus
loin).

Aire de travail

Où vous composez les diapositives de votre présentation.

Zoom

Affiche le niveau de zoom actuel. Par défaut, ce niveau est réglé de sorte que la diapositive puisse être
affichée au complet dans la fenêtre de OpenOffice.org Impress . Si vous redimensionnez la fenêtre de
OpenOffice.org Impress , le niveau de zoom changera afin que la diapositive puisse être affichée dans
son entièreté.
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Onglets des diapositives

Chacune des diapositives composant votre présentation possède un onglet permettant de passer rapide-
ment d’une diapositive à une autre. À la gauche des onglets se trouvent différents curseurs qui fonction-
nent comme les boutons de navigation de OpenOffice.org Calc . Veuillez vous référer à Tableurs, page
74 pour plus de renseignements à ce sujet.

Barre d’outils

Elle contient les outils principaux permettant de concevoir les diapositives, tels que l’outil texte, les for-
mes, les courbes, les lignes et les flèches ; les outils de rotation d’objet, d’effets spéciaux ; ainsi que le
bouton de Présentation à l'écran, tout en bas.

Certains de ces boutons possèdent un petit triangle vert, situé du
côté supérieur droit. En appuyant sur ceux-ci, vous ouvrirez un
menu contenant des options spécifiques à cet outil. Par exemple,
insérer un rectangle (plein ou vide), avec des rebords courbés ou
droits, etc.

10.3.3. Concevoir une présentation

10.3.3.1. Titre de la diapo

Dans l’exemple que nous avons choisi, c’est assez intuitif. Cliquez dans la zone Cliquez pour ajouter un titre.
Écrivez votre titre et cliquez ensuite sur une aire « vide » de la diapo pour sortir du mode d’édition. C’est tout.

10.3.3.2. Insertion de texte

Cliquez sur la boîte du bas pour insérer votre texte (où est écrit Cliquez pour ajouter un plan). Ce que vous
y écrirez sera automatiquement formaté en liste à puces. Vous pouvez changer ces réglages par l’entremise du
menu Format.

10.3.3.3. Ajouter des diapositives à votre présentation

En choisissant Insertion→Page... depuis le menu, la fenêtre type de diapo sera affichée (figure 10-10). Procédez
tel qu’expliqué précédemment.

Choisissez Insertion→Dupliquer la page si vous préférez vous ap-
puyer sur la diapositive courante.

Vous pouvez également faire un clic droit sur la diapo courante et choisir Page→Insérer une page... depuis le
menu contextuel, ou utiliser le bouton d’insertion de la barre d’outils (en standard, elle affiche un graphique
en forme de camembert) pour ajouter une diapo.

10.3.3.4. Graphiques simples

Il est souvent utile de concevoir des diagrammes simples pour expliquer ou montrer un concept. Après tout,
une image vaut mille mots. tableau 10-2 résume les outils disponibles pour concevoir des graphiques simples.
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Bouton Fonction

Bouton Fonction

Permet de dessiner des rectangles et des carrés, remplis ou vides, à angle vif ou
courbe. Faites un clic droit sur l’objet dessiné et choisissez Modi�er le style d'objet
depuis le menu contextuel pour changer la couleur, l’ombre, la transparence, etc.

Permet de dessiner des ellipses et des cercles, vides ou remplis. Vous pouvez créer des
camembert circulaires et des arcs. Faites un clic droit sur l’objet dessiné et choisissez
Modi�er le style d'objet depuis le menu contextuel pour changer la couleur, l’ombre,
la transparence, etc.

Permet de dessiner des objets en 3D tels que des cubes, des sphères, des cylindres, des
cônes, des tores, des pyramides, des coquilles ou des demi-sphères. Faites un clic droit
sur l’objet dessiné, et choisissez E�ets 3D depuis le menu contextuel si vous voulez
modifier le « matériau », l’éclairage, etc.

Permet de dessiner des courbes, des polygones, des lignes libres, remplis ou vides.
Faites un clic droit sur l’objet dessiné et choisissez Modi�er le style d'objet depuis le
menu contextuel pour changer ses attributs.

Permet de dessiner des lignes et des flèches. Les lignes peuvent être dotées de flèches
à l’une ou l’autre, voire aux deux extrémités. Faites un clic droit sur l’objet dessiné et
choisissez Modi�er le style d'objet depuis le menu contextuel pour changer ses
attributs.

Permet de dessiner des « connecteurs ». Ces derniers sont des lignes, droites ou
courbes, avec ou sans flèche, qui permettent de lier des objets ensemble. Faites un clic
droit sur l’objet dessiné et choisissez Modi�er le style d'objet depuis le menu
contextuel pour changer ses attributs.

Tableau 10-2. Outils graphiques

Tout changement de style que vous ferez en utilisant le menu con-
textuel Modi�er le style d'objet écrasera le style standard pour le
prochain objet qui sera dessiné par le style que vous aurez créé.

10.3.3.5. Diagrammes simples

Sélectionnez Insertion→Diagramme depuis le menu pour en insérer un dans la diapo active. Une barre de
diagramme « standard » sera insérée : cliquez et bougez les bordures pour ajuster leur taille.

Utilisez les poignées de coin pour préserver les proportions hori-
zontales/verticales lorsque vous redimensionnerez le diagramme. Si
vous utilisez les poignées du milieu , le diagramme sera quelque
peu déformé.

Double-cliquez sur le diagramme puis, faites un clic droit sur celui-ci et choisissez Données du diagramme.
Une fenêtre (figure 10-12) apparaîtra vous permettant d’entrer les données pertinentes au diagramme que
vous voulez créer.
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Figure 10-12. Entrer des données dans un diagramme

Une fois que vous aurez entré les données dans le diagramme, fermez la fenêtre d’entrée de données et cliquez
sur Oui pour actualiser votre diagramme dans la diapo. Puis cliquez sur une aire vide de la diapo.

Répétez l’opération de double-clic et de clic droit afin de changer le titre, la légende, l’axe, le type (2D ou 3D),
la barre, le camembert, les points, les lignes, etc., du diagramme en choisissant les entrées appropriées depuis
le menu contextuel.

10.3.3.6. Arrière-plan de diapo

Utilisez le menu Format→Arrière-plan et cliquez sur l’onglet Arrière-plan pour définir les couleurs, les dégra-
dés, les hachures, etc. de votre diapo. Chaque type d’arrière-plan possèdent ces propres options, explorez-les.

L’utilisation de bitmap en arrière-plan augmente considérablement
la taille d’un fichier. Ceci pourrait engendrer un gel de votre pré-
sentation, surtout sur les vieux systèmes.

Une fois que vous aurez choisi un arrière-plan et cliquez sur OK, un menu apparaîtra. Vous devrez choisir de
définir (ou non) cet arrière-plan en standard pour les nouvelles diapositives. Faites votre choix et l’arrière-plan
des diapositives sera actualisé.

10.3.3.7. Transitions, animations et effets

Depuis le menu Présentation à l'écran, il est possible d’appliquer des transitions, des animations et des effets
à vos diapositives, ce qui peut dynamiser vos présentations. Encore une fois, explorez-les librement.

Essayez de ne pas abuser de ces effets spéciaux. Ils pourraient dis-
traire votre public et détourner leur attention vers les effets en tant
que tel, au détriment de votre contenu.

10.3.3.8. Lancer votre présentation

Vous pouvez lancer votre présentation par l’entremise du menu Présentation à l'écran→Présentation à l'écran,
ou en appuyant sur la touches F9. Vous pouvez aussi cliquer sur le bouton correspondant dans la barre
d’outils. La présentation s’affichera sur l’entièreté de votre écran. Pour arrêter la présentation, appuyez sur
la touche Échap.
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10.3.4. Pour aller plus loin

Si vous souhaitez en apprendre plus sur le fonctionnement de OpenOffice.org Impress , vous devriez
consulter le tutoriel disponible sur le site OpenOffice Support (http://www.openofficesupport.com/
impresstutorial.html).

N’hésitez pas non plus à vous reporter à l’aide en ligne de OpenOffice.org Impress accessible grâce au menu
Aide→Sommaire. Vous y trouverez la réponse à toutes vos questions. Les sujets sont accessibles par la table
des matières, mais aussi par l’index et il y a un outil de recherche contextuel.

10.3.5. Conclusion

Les présentations s’avèrent une façon importante de transmettre vos idées, que ce soit à vos clients, vos profes-
seurs, vos étudiants ou vos collègues de travail. En tentant d’appliquer le principe qui dit que « La simplicité
est synonyme d’élégance » –– c’est-à-dire d’éviter de surcharger votre présentation avec des graphiques, de
grands diagrammes ou des animations et des effets complexes ––, votre public sera attentif à ce que vous
tentez de lui communiquer.

OpenOffice.org Impress possède les outils pour faire de magnifiques présentations, utilisez-les à bon es-
cient !
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